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Introduction

This introductory chapter will guide you through the features and workflow of using Gen5 for
microscopy. These overview topics include references to more specific information provided in
subsequent chapters. Whether you are a new user or need a refresher on how to use Gen5, this is
the place to start.

Note: Gen5 version 3.12 or higher is required to perform all features herein described.

This guide assumes user familiarity with basic digital microscopy concepts such as objectives,
fluorescence, filters, etc.

1.1 - The Gen5 Microscopy Workflow 5
1.2 - Important Gen5 Imaging Concepts 6
1.3 - Capture an Example Image 18
1.4 - Create an Experiment from the Example Image 21
1.5 - Saving Gen5 Files and Defining the Image Library 26
1.6 - Example Exercises 30

This manual is intended for use with the following instruments and software:

Instruments

Lionheart FX LFX, LFXW

Lionheart LX LLX, LLXW

Cytation C10 C10PHC2, C10MPHC2, C10PWC, C10MPWC,
C10PW, C10MPW

Cytation 7 CYT7U, CYT7UW, CYT7UMW, CYT7UM

Cytation 5 CYT5FV, CYT5FW, CYT5FAV, CYTFAW, CYT5MV,
CYT5MW, CYT5MPV, CYT5MPW, CYT5MFV,
CYT5MFW, CYT5MFAV, CYT5MFAW, CYT5V,
CYT5W, CYT5PV, CYT5PW

Cytation 1 CYT1FAV, CYT1V

Gen5 Software
l GEN5

l GEN5SECURE

l GEN5IPLUS

l GEN5IPRIME
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1.1 - The Gen5 Microscopy Workflow

This introductory chapter ensures you will be prepared for success. Before you begin using your imager,
read and understand this important information.

The first thing you may notice about your Cytation or Lionheart is the absence of eyepieces! Instead, all
imaging on Agilent microscopes is performed digitally using Agilent Gen5 software. Gen5 software also
contains image processing and analysis tools. The equivalent of eyepieces in Gen5 is Imager Manual
Mode. This mode (described in 2 - Quick Guide to Imaging on page 36) lets you view your samples and
operate the microscope just like a manual microscope.

However, Gen5 is designed to assist in automating your microscopy workflows (termed “Protocols” in
Gen5). Gen5 allows you to easily repeat previously saved protocols. To properly follow along with these
instructions you need a sample plate ready to image.

As you will soon see, the best way to define a Gen5 Protocol is to use one of your own biological samples.
This eliminates guesswork on the best settings. The remaining sections in this chapter will walk you
through the process of creating a new protocol from scratch. If this is your first time working with Gen5
(or if you want a refresher), start with 1.2 - Important Gen5 Imaging Concepts on the facing page, which
defines key terms and concepts for successfully using Gen5.

The process to create a new protocol follows three steps.

1. Capture an Example Image. Start by capturing a new image. Acquiring a good image requires
properly adjusting focus and exposure settings. This image is used to test image processing and
analysis steps. Covered in 1.3 - Capture an Example Image on page 18.

2. Create an Experiment from the Example Image. The captured image is used to create an
experiment. A Gen5 Experiment is the automated acquisition, processing, and analysis of images
across a microplate or other vessel. This is covered in 1.4 - Create an Experiment from the Example
Image on page 21.

3. Save the Protocol to Automate Future Experiments. After creating a perfect protocol, you will want
to save your hard work to use it again. 1.5 - Saving Gen5 Files and Defining the Image Library on
page 26 covers saving a protocol and using it in future experiments.

Finally, 1.6 - Example Exercises as shown on page 30 contains exercises to test your understanding.
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1.2 - Important Gen5 Imaging Concepts

Start by launching Gen5.

The Task Manager will be displayed. Select a Task Manager menu item to display related controls for that
task.

l Read Now: Immediately run an experiment.

l Imager Manual Mode: Use the imager as a manual microscope to view your sample live and
capture one image at a time.

l Experiments: For automated acquisition and analysis: run an existing experiment or create new
experiments.

l Protocols: Experimental design without data.
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l Instrument Control: To control the imager independently, including incubation, opening/closing
the carrier, priming and dispensing, gas recharge, etc.

l Setup: Configure instrument; define preferences, security, and System Menu.

l Help: Access the Gen5 Help topics, FAQs, Sample Files, and the contact information for Technical
Support.

The above tasks will be referenced in the following sections. You will use the Imager Manual
Mode and Experiments tasks most often. Also note that the Task Manager can be closed to
access the menus at the top of the Gen5 window. The Task Manager may be reopened at any time
by clicking the Gen5 icon.

The following key concepts are essential for understanding the microscopy workflow in Gen5. Several of
these concepts are covered in more detail at the end of this section.

l Manual Mode vs. Experiments: Gen5 offers two ways of imaging. Manual mode (1.3 - Capture
an Example Image on page 18 and 2.1 - Acquiring an Image on page 37) is used to manually
customize all aspects of the image acquisition. This mode is most commonly used to take a few
images or take a representative image for the creation of an experiment. Experiment mode is for
automated acquisition of images across a microplate or vessel. Images are automatically acquired
based on settings defined for a representative image captured in manual mode. The settings for an
experiment are saved in a Protocol file.

l Plate Types: For automated microscopy, the dimensions of the microplate must be known by
Gen5 to properly image the wells. The plate definition also contains important information: the
bottom thickness of the plate and the default focus location (referred to in Gen5 as the Bottom
Elevation). Gen5 has pre-made definitions for many common microplates. Selecting the correct
plate type is critically important for successful imaging. If you need assistance selecting the
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correct plate type or creating a new plate type, contact Technical Support or your Field Applications
Scientist.

Important: Never use the plate types named “WELL PLATE” (e.g., 6 WELL PLATE, 96 WELL
PLATE, etc.) for imaging experiments. These plates are in Gen5 for compatibility for non-
imaging workflows. For more information about plate types: See Everything you ever wanted to
know about Plate Types on the next page.

l Bottom Elevation: The autofocus default starting location for the Plate Type. It is critical to
optimize this before using the plate in Experiment mode; otherwise, poor autofocus performance is
expected. Gen5 offers several ways to set the Bottom Elevation, including the method described
here: Setting the Bottom Elevation.

l Correction Collars: Correction collars make fine adjustments in the high-power objectives (20x,
40x, and 60x air) to compensate for changes in the vessel thickness to still achieve crisp focus. You
must adjust the correction collar on objectives to match the bottom thickness of the sample vessel.
If the collar is improperly adjusted images will be blurry and autofocus may have difficulty. See
Adjusting the Correction Collar on page 15 for more details.

l File Types: Gen5 uses three different file types and an image storage directory for storing imaging
data:

l Image Manual Mode Sessions (.IMM): These files store Manual Mode sessions. They can
be re-opened to view images, take additional images in the session, or create new
experiments. The default name is DATE_TIME_IMM Session.imm where DATE & TIME are the
date and time that the session was started. The DATE is in year, month, day (YYMMDD)
format. The TIME is in hour (24-hour), minute, second format. The raw images are not stored
in the .IMM file. Instead an image storage folder containing the raw image files is created,
called Gen5 Image Library.

Image files are large and storing them can quickly exceed your computer’s memory. An
external hard drive or similar device is recommended for storing the Gen5 Image Library.
Using a cloud drive for storing image files is not recommended.

Important: Both the image storage folder (Gen5 Image Library) and the IMM file are
necessary for opening the Gen5 Manual Mode session. Both must be copied to a new
computer to open the file.

l Experiment Files (.XPT): The experiment file contains settings and data collected during an
experiment from Experiment Mode. The raw image files are not stored in the experiment file.
Instead an image storage folder containing the raw image files is created, called Gen5 Image
Library.

Important: Both the image storage directory and the XPT file are necessary for opening
the Gen5 experiment. Both must be copied to a new computer to open the file.

l Protocol Files (.PRT): The Protocol file contains only the settings to create an experiment.
It is different from an Experiment file in that it does not contain data. Its purpose is to create
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new experiment files with the same settings to repeat experiments, run experiments using
the BioSpa 8, or run experiments with a 3rd party automation platform.

l Image Storage Directory: The location of the Gen5 Image Library is defined when Gen5 is
installed (1.5 - Saving Gen5 Files and Defining the Image Library on page 26). Gen5 creates
a separate folder in the image library to store the acquired images of each imaging session.
The name of the folder contains a DATE and TIME prefix (see the DATE & TIME formats in the
Manual Mode section above for the format) followed by the name of the Manual Mode session
or Experiment file. These folders are essential for opening Gen5 files. To open an imaging
session on another computer, both the corresponding image folder and .IMM or .XPT file
must be copied or moved to the same location on that computer. This can be done manually
or using a zip file created in Gen5 (as described on page 200). In addition, Gen5 can export
images into a variety of formats including color or grayscale TIFF, PNG, JPEG, etc.

Everything you ever wanted to know about Plate Types

The plate definition is more than just a map of your wells. It provides critical information to enable the
imager to find focus and protect your objectives and samples. To access the Plate Type Library, close the
Task Manager and:

l In Gen5, select System>Plate Types and Copy the plate type that is most similar to your
vessel.

l You need: The plate/vessel with properly prepared samples.

Important: At a minimum, you must set the Bottom Elevation and Bottom Thickness to achieve the
best results!
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Setting the Bottom Elevation
The bottom elevation may be defined either in Manual Mode or in the Plate Types window. However, be
aware that the bottom elevation is a global change to the currently selected plate type and your changes
will affect all other users who share this plate type. A safer practice is to create your own “Copy” of the
plate type and make changes to that plate type record. This is particularly true if multiple users use
different types of samples on the same plate type. The directions below show how to update the bottom
elevation from the plate types window.

Bottom Elevation:
To define Bottom Elevation:

1. Put the sample plate on the carrier.

2. Click

3. Focus on the sample; check the plate
center and corners. When the image
is satisfactory, click

Note: Do not use the Finder Scope of
the upright imager to determine bottom
elevation.

Setting the Bottom Thickness:
This value comes from the plate manufacturer and can be found on the specification sheet or by
calling the manufacturer.

See also 11.4 - Labware on page 233.
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Setting the Accessible Bottom Focus Region
For objectives 20x and higher, the accessible bottom focus region must also be defined.

1. Fill the checkbox to “Define Accessible Bottom Focus Region.”

2. Click the button to “Generate default values from existing well definitions.”

3. Enter a Bottom thickness - review specifications from vessel manufacturer or begin with a
guesstimate, e.g., 500 µm for a standard microplate, 200 µm for a slide holder.

“Max distance below carrier” is typically 0. This parameter supports hanging-drop plates and special
vessels like T25 flasks in an adapter.

4. Save settings.
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Use AutoMapping to Precisely Define Well Position

Gen5’s Auto Map feature makes it easy to precisely define the position of wells in
your plate type. This is an important first step to performing ELISPOT assays, and other whole-well
assays. Run Auto Map to tell Gen5 exactly how to center wells in images.

Note: This feature does not support slide holders, flasks, or similar labware. It is designed for
standard microplates.

Upright imager: Transmitted light source is a good choice for Auto Map with an empty plate.
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Using an empty plate , click Run and follow the prompts.

When both wells appear to be positioned correctly, click OK to save the offsets.

Gen5 will update the plate type record.
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Adjusting the Correction Collar

Correction collars make fine adjustments in the objective to compensate for changes in the vessel to still
achieve crisp focus. You must adjust the correction collar on high-power objectives, 20X, 40X, and 60X
air, tomatch the bottom thickness of the sample vessel. If the collar is improperly adjusted
images will be blurry and autofocus may have difficulty. Redo this step for new or different vessels, as
needed.

Use Manual Mode to access the objective:

When you click Access Objective, the turret will lower and rotate to position the objective you are
currently using for removal. Open the access door and identify the objective. Objectives can be identified
by the colored band around the objective.
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Magnification Color Magnification Color

1.25X Black 20X* Green

2.5X Brown 40X* Light Blue

4X Red 60X* Cobalt Blue

10X Yellow * objectives with correction collars

After identifying the objective, locate the correction collar, scale, and alignment mark. (It is not
necessary to remove the objective from the turret.) Turn the collar until the alignment mark indicates
the bottom thickness of your vessel in mm. This should be the same value you input for the
Bottom Thickness of your plate definition, adjusted to mm.

For example, a Bottom Thickness of 500 μm will have a correction collar set to 0.5.

After adjusting the correction collar, close the access door and click OK. The instrument will return to the
same x-, y- and z-coordinates as prior to the correction. You will need to re-focus the field.

For reference here are some common Bottom Thickness values:
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Plate Type Typical Bottom Thickness*

Glass-bottom microplate 0.17 mm

Film-bottom imaging plastic microplate 0.19 or 0.5 mm

Generic plastic microplates** 1.3 mm (can be up to 2.0 mm)

Other plastic labware (Petri dish, T-25 flask)** 1.3 mm (can be up to 2.0 mm)

Slide with glass cover slip 0.17 mm

*These are typical bottom thicknesses. Check your plate manufacturer's specifications for the actual
bottom thickness.

**Although correction collars can adjust to these larger thicknesses, the best image quality at higher
magnifications is always achieved with film or glass bottom microplates (or other vessels) with a bottom
thickness of 0.5 mm or less.

Objectives can be accessed using the Reader Setup button on the toolbar or via the Gen5
menu: System>Instrument Configuration> View/Modify>Setup. Click Access next to the
objective of interest.

Learn more about the imaging objectives and LED filter cubes: See 11.1 - Instruments and Accessories
on page 215.
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1.3 - Capture an Example Image

Preparing to Capture an Image

Before you begin, prepare your sample for imaging and identify which Plate Type corresponds to
the vessel containing your sample (See Everything you ever wanted to know about Plate Types on
page 9.)

Click theManual Mode button to begin. Select the Plate Type and load the plate into the
instrument.

Guidelines for Capturing an Image in Manual Mode
See also 2.1 - Acquiring an Image on page 37 and 2.5 - Additional Acquisition Options on page 51.

Chapter 2 of this training guide covers Manual Mode in detail. The purpose of this section is to outline how
to use imager manual mode to accomplish your scientific goals. You may wish to reference section 2.1
before starting this section if you have never used manual mode before (or need a refresher) to see how
to accomplish each of these steps and for more fine details on the operation of manual mode.

The first step is to bring an image into focus. Select awell that contains sample; a color channel that is
present in the sample; and the desiredmagnification. (If you are unsure how to do this or any of the
following steps, stop now and read section 2.1.)

Next, click Find Image to automatically adjust the focus and exposure. If this is the first time using the
plate definition, the bottom elevation may be incorrect and autofocus will fail. If this happens, manually
adjust the focus to bring the sample into focus.

Update the Bottom Elevation: If this is the first time you have used this plate definition and/or a large
change in focus was required from the default position (> 100 um), it is critically important to update the
bottom elevation of the plate. The bottom elevation is the default focus location. Updating it will save you
time in the future when using this plate (manual mode will start at the bottom elevation setting) and most
importantly the bottom elevation is the starting point for the autofocus routine in experiment mode. Most
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issues with the autofocus in experiment mode stem from having an incorrect bottom elevation setting.
To update the bottom elevation: expand the Focus panel, and select Update vessel’s bottom
elevation.

For more information see: Setting the Bottom Elevation.

Once the bottom elevation is set, the next step is to capture a reference image. This paragraph describes
how to capture a single reference image. If your experiment requires a montage or z-stack, read through
the directions here, as the same principles apply, and then see the “Multidimensional” paragraph below.

The best practice is to set the exposure and focus settings on
the brightest well in your sample (often the positive control).
Navigate to that well. (Click theWell button.)

The most important choice is the first color to capture. The
first color channel is used for autofocus in Experiment mode.
This color channel must be present in every well and should be
bright with good contrast. Common choices for the focus
channel include nuclear stains (e.g. DAPI, Hoechst, DRAQ5),
brightfield, or phase contrast.

Choose the first channel and adjust the exposure and focus.

When the first channel is captured, switch to the next color channel, adjust the exposure and focus, and
capture it. Repeat until all of the colors required for your experiment have been captured for a single
image. When all channels are captured, click Process / Analyze, described below.

Note: If using a 20x, 40x, or 60x air objective and the image cannot be focused manually, the
correction collar may need to be adjusted. See Adjusting the Correction Collar on page 15.

Multidimensional acquisition is defined on the Imaging Mode panel. Options include montage (3.3 -
Image Montage on page 64), z-stack (3.4 - Z-Stacking on page 72), and kinetic (3.5 - Kinetic Image
Capture as shown on page 79). The montage and z-stack acquisitions are useful for creating an image
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set to create a protocol. The kinetic settings are used for imaging a specific cell location. All of these
options can be added later; and, in most cases kinetics should be added to an experiment later.

Guidelines for Processing Images in Manual Mode
See 2.3 - Image Processing and Analysis on page 45; or See 6 - Image Processing on page 138.

Image Processing methods are discussed in detail in Chapter 6. Here are more general guidelines on
when to apply them:

l Image Preprocessing is the most commonly used processing method. Image Preprocessing uses
a rolling ball algorithm to smooth uneven backgrounds. Typically recommended for fluorescent
images with their dark backgrounds, applying Image Preprocessing prevents future samples from
having background issues. Only apply it to brightfield images that need to be quantified. The size of
the rolling ball may be adjusted for each channel and should be set to 2-3 times the size of the
object of interest in most circumstances.

l Image Deconvolution applies a 2D deconvolution to the image. Deconvolution most improves
images of 20x and higher magnification of small objects ( < 500 nm in size). If deconvolution is
used, it should be applied to the raw image.

l Image Stitching is only applied to image sets with a montage. It stitches the image together to
provide a single, seamless image for analysis and export. Only images with overlap need to be
stitched.

l Z-Projection reduces the z-stack from a series of z-images to a single image.

l Kinetic Frame Alignment aligns the images from a kinetic series. This tools is qualitative only for
movie export and viewing. It does not affect any analysis results.

l Digital Phase Contrast converts a standard brightfield image into a phase-like image (background
is changed from light to dark). This is useful for full well images in 96- and 384-well plates that have
a large meniscus effect in phase contrast.

Guidelines for Analyzing Images in Manual Mode
l 2.3 - Image Processing and Analysis on page 45.

l 7 - Basic Image Analysis on page 148.

l 8 - Advanced Analysis as shown on page 168.

All of the analysis in Gen5 is accomplished using Cellular Analysis or Image Statistics.

Image Statistics is primarily used to measure the physical size (length, width, area) of the image for
use in other calculations (e.g., confluence). The primary tool is Cellular Analysis: described in Chapter 7
(Image+ & Image Prime) and Chapter 8 (Image Prime). Specific details for defining cellular analysis
depend on the sample and the scientific goals of the analysis.

However, some general principles include: All cellular analysis begins with a count of a specific color
channel. What is counted depends on the analysis goals. For example, counting cells would select a
marker (e.g., DAPI) that identifies each nucleus/cell or, if confluence wants to be measured, a whole cell
stain would be selected (e.g., Calcein). From there “subpopulations” can be identified to perform
additional counts based upon unique criteria. For example, in a live/dead experiment where two nuclear
stains are used, the initial count would count the color that stains all cells live or dead (e.g., Hoechst).
Then a subpopulation counts the number of cells that are also stained with the dead cell color (e.g.,
propidium iodide). Details on how to perform each of these steps are given in Chapter 7 & section 2.3.
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1.4 - Create an Experiment from the Example Image

After the example image is captured, processed, and analyzed, the entire image session can be
converted to an Experiment to batch process the entire plate and save a protocol to use for future
experiments.

The Experiment is created by first selecting the image and then either clicking on the Create Experiment
button or right-clicking on the thumbnail and clicking “Create Experiment from this image set.” Both
options open a new Gen5 Experiment window with the Procedure settings displayed. All the acquisition
settings from the example image session have been copied to the Procedurewindow. Any processing or
analysis steps have been copied to theData Reductionwindow (which will be addressed later in this
section). Several common settings that you may want to add to your protocol are addressed in the next
sections. If you do not need to add any of these, you may skip ahead to the Data Reduction section.

Selecting Wells To Image
By default, every well on the plate will be imaged. Two options let you select specifically which wells to
image on the plate.

The options are chosen with the Select wells buttons immediately below the Plate Type field in the
Procedure.
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1. Select wells: Per step. This is the default option. This option will run the wells configured on each
imaging step. To select the wells, open the imaging step by double clicking on it and select the box
in the upper right corner. By default this button says Full Plate, but if wells were previously
selected it will have the range or number of wells listed.

This option is useful if the same wells will be read every time the protocol is run. It is also required
when using the Biostack, BioSpa, or another robotic integration using Gen5 OLE.

2. Select wells: At runtime. The option will ask you each time the protocol is run which wells to
image. The same wells will be imaged on each step of the procedure (if there are multiple imaging
steps). This option is not compatible with the BioSpa or another robotic integration using Gen5 OLE.

Autofocus Settings
See 5 - Understanding AutoFocus on page 124.

Successful imaging requires understanding and choosing the best autofocus method for your sample. By
default, Gen5 uses an image-based autofocus that is the same as clicking “Auto Focus” in imager manual
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mode. The most common adjustment is to use the Laser AutoFocus (LAF) accessory. See 5.2 - Laser
AutoFocus on page 132.

Temperature
For applications requiring a specific temperature setting (e.g., live cell imaging), the Temperature step
should be the first step in the protocol. This will bring the microscope up to temperature before asking
you to load your plate. To add a temperate step, click Set Temperature under Actions in the left panel.

Set the desired temperature. For brightfield or phase contrast imaging, it is recommended to add a 2ºC
gradient to keep condensation from forming on the lid. If the temperature step is not listed first in the
protocol, click and drag it to the first spot.

Kinetic Acquisition
See 3.5 - Kinetic Image Capture on page 79.

There are two options for kinetics in Gen5. Setting up the kinetics options differ and the choice depends
on the experimental needs. The two options can also be combined in an Experiment.

1. Kinetics. The standard kinetics option is used when you want Gen5 to time the experiment. The
plate will remain in the instrument during the entire experiment. This is typically done for rapid
kinetics.

2. Discontinuous Kinetics. Discontinuous kinetics allows for the removal of the plate between each
time point. The timing of the plate reads is controlled by the user. This is typically used for long term
assays where the instrument needs to be used between each read. This is also commonly used for
BioSpa and Gen5 OLE kinetic protocols.

3. Combining Kinetic and Discontinuous Kinetics.When both kinetics options are applied, Gen5
appends the data for each standard kinetic image set for analyzing all the results collected during
the time span. Set both kinetics options if this is useful for the experiment.

To configure standard kinetics, click Start Kinetic under Kinetic on the left panel of the Procedure
window. The kinetic run is defined by setting the total time (duration) and the interval (image capture
frequency). The Image step needs to be inside the kinetic loop as shown below.
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If the steps are not properly positioned, drag and drop them in the Procedure window.

To turn on Discontinuous Kinetics, click Options under Other on the left panel of the Procedure
window.

The Discontinuous Kinetic run is defined by setting the total time and interval. These are only estimates.
The final time stamps are recorded when the plates are read. If you are unsure about the total number of
time points, it is best to overestimate. There is no kinetic loop or other indicator shown for a
Discontinuous Kinetic, so the Procedure window will look the same before and after it is added. See
Discontinuous Kinetics on page 80.

Data Reduction
l 6 - Image Processing on page 138

l 7 - Basic Image Analysis on page 148

l 8 - Advanced Analysis on page 168

Many of the above adjustments to the Procedure will invalidate a Process or Analysis step that was
defined in manual mode. In experiment mode, all of the Process and Analysis steps are listed under Data
Reduction. If that is the case, the message below will appear.

Every step that is covered with a “red no” symbol needs to be addressed. In most cases, double clicking
the step and then clicking OK to close it will clear the issue. However, in some cases you will need to
select a new data set input. In these cases, a message will appear when clicking “OK”.
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More Data Reduction steps can be added to do transformations that cannot be performed in imager
manual mode. These are covered in the Gen5 online help in Help > Help Topics > Define Data
Reduction Requirements.
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1.5 - Saving Gen5 Files and Defining the Image Library

Image file sizes are significantly larger than other data files.

Widefield (standard field-of-view) image files are
at least 2 MB each.

A 4x4 montage per well of a 96-well plate will
require 3327 MB of storage space.

Confocal and Wide Field of View (WFOV) camera
imaging create files around 7.57 MB.

A 4x4 montage per well of a 96-well plate will
require 11.6 GB of storage space.

Using an external hard drive or another form of additional storage for images is strongly recommended.
However, storing images on a cloud drive is not recommended.

During installation of your imager and Gen5 software, it is likely that default settings were retained. To
check or change these settings, close the Task Manager and select System > Preferences from the
Gen5 menu. Changes are global and will change storage location of future experiment, protocol, and
image files.

Select: System>Preferences
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Image Save Options

Raw image files are large compared to other Gen5 data files, so they are handled differently. Images are
stored in the Windows File System in a user-specified location. Click Browse to redirect your image files.

See also 9.1.2 - Strategies for Data Management on page 201.

Save the Protocol to Automate Future Experiments

The Protocol file (file extension .PRT) stores all of the experiment settings for repeating the same
experiment. In other words, the steps described above in sections 1.3 & 1.4 only need to be performed
once per experimental design.

When you are ready to execute the experiment click the “Read New" button that looks like a play
button in green. Gen5 will ask you to save the experiment (.XPT file) and then execute the
protocol as designed.

The protocol is not saved when the experiment is saved. (Remember, experiments and protocols are two
separate files.) The Protocol file can be saved at any time from an experiment by selecting File > Save
Protocol As. And, when closing an experiment, you will be prompted to save the protocol file if it hasn’t
been saved before.
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If the protocol has been previously saved, you will be prompted to either “Update”, “Save As”, or “Ignore”
any changes made to the Protocol.

When the protocol file has been saved, you can use the protocol to repeat the same experiment. In the
Task Manager, select Experiments and Create using an existing protocol….
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A new Experiment window will open containing all of the previously defined settings. You may modify
settings or begin acquiring data in the new experiment.
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1.6 - Example Exercises

Below are example exercises to test your understanding after reviewing the concepts in this introductory
chapter and the details in the following chapters. As you think about how to approach performing these
exercises, keep in mind the following workflow:

1. Prepare to image:

1. Know which Gen5 plate type matches your plate. If necessary, make a new Plate Type (copy
a plate-type record) before starting, and adjust Bottom Elevation (and other imaging
settings).

2. Start Manual Mode, select the plate type, and load the plate with your sample into the
instrument.

2. Capture an example image:
1. Focus and adjust the exposure to get a good image. If this is the first time using the plate

or if a large change in focus is required ( > 100 um) to find the initial image, update the
bottom elevation of the plate.

2. Go through the Augmented Microscopy workflow:
1. Capture: Acquire all of the colors necessary for the experiment. The first color

acquired is the focus channel. The focus channel should be bright and present in all
of the wells. Common focus channels are nuclear stains (e.g., DAPI, Hoechst,
DRAQ5), brightfield, or phase contrast.

l If a montage and/or z-stack is required, define them in the Manual Mode
session to acquire these images.

2. Process: Add processing steps to the example image. Image Preprocessing is used
in most experiments. Add Image Stitching or Z-Projection if capturing a montage or
z-stack, respectively.

3. Analyze: Add analysis steps to create the desired quantitative data from the
image.

3. Create an Experiment from the example image:

1. Click the Create Experiment button or right-click on the thumbnail and click “Create
experiment from this image set.”

2. Adjust the following settings in the Procedure as needed:
1. Select Wells To Image

2. Autofocus Settings

3. Temperature

4. Kinetic Acquisition

3. If prompted, update the necessary Data Reduction (analysis) steps, as needed.
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4. Save the Protocol to automate future experiments:

1. Protocols are saved using File > Save Protocol As or by closing the Experiment and choosing
to “Update” or “Save As” the protocol when prompted.

2. Create a new experiment using a previously created Protocol in the Task Manager by
selecting Experiments then “Create using an existing protocol.”

****************************************************************

Exercise 1: Fluorescent Cell Counting
Goals:

A) Automate acquisition of a single image of DAPI in a 96 well plate.

B) Count the number of DAPI labeled cells in a single image.

C) Estimate the total number of cells in the well based upon the single image.

Exercise 2: Fluorescent Confluence
Goals:

A) Automate acquisition of a single image of DAPI & GFP in a 96 well plate.

B) Measure the confluence of cells in the image based upon the full cell GFP signal.

Exercise 3: Transfection Efficiency
Goals:

A) Automate acquisition of a single image of DAPI & GFP in a 96 well plate.

B) Count the number of DAPI labeled cells in a single image.

C) Count the number of GFP positive cells in the image.

D) Calculate the GFP transfection efficiency in each well.
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Agilent BioTek Imaging Training Video Series 

In this training video series, you will learn how to acquire and analyze images and plate reading data 
from our instruments within the Agilent BioTek Gen5 microplate reader and imager software. These 
training videos are designed to help you capture, process, and analyze the data you have so that you 
can publish faster. 

Click on the link to watch the video. 

Video Name Description 

Basic Image Analysis Concepts-Part 1 This training video explains the concept image 
thresholding, both in image statistics and cellular 
analysis functions. There is also a 
demonstration of how to add Image Statistics to 
your protocols. 

Basic Image Analysis Concepts-Part 2 In this training video, we demonstrate how to 
determine and add object threshold and sizes for 
your samples. This video also shows how to 
adjust advanced detection options such as 
rolling ball to create cellular analysis and object 
masking in Gen5. 

Basic Image Analysis Concepts-Part 3 This training video explains how to add Object 
level metrics from Primary Masks, create plugs 
and subpopulations in Gen5. 

Converting from Manual Mode to Experiment 
Mode 

This tutorial will walk you through creating an 
experiment from a manual mode session, where 
to visualize and modify protocol settings, how to 
run your experiment and visualize your data, and 
finally, how to save protocols for later use in the 
Gen5 software. 

High Contrast Brightfield This video demonstrates how to use high 
contrast brightfield for label-free cell counting. It 
covers settings for capturing images in manual 
mode, as well as process/analysis steps to 
obtain accurate cells counts. 

https://download.chem.agilent.com/videos/ITVS%20Basic%20Image%20Analysis%20Part%201%20RA.44216.2594560185.mp4
https://download.chem.agilent.com/videos/ITVS%20Basic%20Image%20Analysis%20Part%202%20RA44216-2602199074.mp4
https://download.chem.agilent.com/videos/ITVS-Basic-Image-Analysis-Part-3-RA44216.261099537.mp4
https://download.chem.agilent.com/videos/ITVS%20Convert%20MM_to%20XPT%20RA-44216-2628125.mp4
https://download.chem.agilent.com/videos/ITVS%20Convert%20MM_to%20XPT%20RA-44216-2628125.mp4
https://download.chem.agilent.com/videos/ITVS-High-Contrast-Brightfield-RA.44216.2642361111.mp4
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 Kinetics Overview This training video demonstrates how to add 
continuous and discontinuous kinetics to 
existing imaging protocols and discuss best use 
for each type of kinetic workflow. 

ROI Feature This training video reviews the ROI feature in 
Gen5 and demonstrates how to set up an 
experiment using this feature. 

Gen5 File Types and the Image Library This video discusses different data types in 
Gen5 and explains where the data saved in Gen5 
and how to change that. Additionally, it explains 
how Gen5 uses tiered file organization systems 
to save the captured images inside the 
experiment folder. 

Montage Image in Manual Mode This video demonstrates how to create a 
montage image in manual mode. By the end of 
this tutorial, you will be able to capture multi-
channel montage images and learn how to apply 
image stitching to create a single image from 
montaged tiles. 

Image Exposure Settings A review of the fundamentals in fluorescent 
imaging and how to adjust acquisition settings 
to best suit your needs. 

Save Color Images in Manual and Experiment 
Mode 

This video covers saving single-color images 
both in the manual and experiment modes. It 
also covers the batch image save option in the 
experiment mode. 

Data Management in Gen5 This video explains how to relink image folders 
to the saved experiment files. Additionally, it 
shows how to create a zipped file for better 
managing and archiving the data. 

Z-Stack Image in Manual Mode This video explains how to create a z-stack 
image in the manual mode. By the end of this 
tutorial, you will be able to capture multi-channel 
z-stack images and learn how to utilize image
processing tools in Gen5 to create a final z-
projected 2D image for better visualization of the
capture 3D image.

https://download.chem.agilent.com/videos/ITVS%20Kinetics%20Overview%20RA.44216.2650115741.mp4
https://download.chem.agilent.com/videos/ITVS-ROI-Feature-RA.44216.2657986111.mp4
https://download.chem.agilent.com/videos/ITVS-Gen5-File-Types-and-the-Image-Library.mp4
https://download.chem.agilent.com/videos/ITVS-Montage-Image-in-Manual-Mode.mp4
https://download.chem.agilent.com/videos/ITVS-Image-Exposure-Settings.mp4
https://download.chem.agilent.com/videos/ITVS-Save-Color-Images-in-Manual-and-Experiment-Mode.mp4
https://download.chem.agilent.com/videos/ITVS-Save-Color-Images-in-Manual-and-Experiment-Mode.mp4
https://download.chem.agilent.com/videos/ITVS-Data-Management-in-Gen.mp4
https://download.chem.agilent.com/videos/ITVS-Z-stack-Image-in-Manual-Mode.mp4
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Image-Based Autofocus Gen5 has five different image-based autofocus 
methods. At the end of this video, you will 
understand how image-based autofocus works 
and the default autofocus settings in Gen5. 

Laser Autofocus This training video reviews how laser autofocus 
works, when the laser autofocus accessory 
should be used, and how you can select to use 
laser autofocus for your experiment. 

Plate Definition This tutorial will walk you through the steps to 
create a cell count in Gen5’s manual mode 
workspace as well as general use of the 
interface. By the end of this tutorial, you will be 
able to capture multi-channel images, add 
preprocessing to your image, and create a basic 
cell count. 

Custom Vessel Definitions In this training video, you will learn three different 
ways to create a new plate type or custom 
labware in Gen5. 

Basic Cell Count in Manual Mode This tutorial will walk you through the steps to 
create a cell count in Gen5’s manual mode 
workspace as well as general use of the 
interface. By the end of this tutorial, you will be 
able to capture multi-channel images, add pre-
processing to your image, and create a basic cell 
count. 

DE44467.3264467593

© Agilent Technologies, Inc. 2021 

https://download.chem.agilent.com/videos/ITVS-Image-based-Autofocus.mp4
https://download.chem.agilent.com/videos/ITVS_Laser_Autofocus.mp4
https://download.chem.agilent.com/videos/ITVS-Plate-Definition.mp4
https://download.chem.agilent.com/videos/ITVS-Custom-Vessel-Definitions.mp4
https://download.chem.agilent.com/videos/ITVS-Basic-Cell-Count-in-Manual-Mode.mp4


35

Introduction



2 - Quick Guide to Imaging

Manual Mode allows you to use your imager as though it were a manual microscope without the
oculars. Manual Mode sessions are saved with the filename extension .imm and can be opened
again at a later time from the Task Manger: select Imager Manual Mode.

Manual Mode allows you to acquire a single field at a time in up to 6 colors. If you keep the same
position in focus, i.e., do not change the x-, y-coordinates, when you begin capturing images, Gen5
overlays up to six channels in one image.

The goal of this section is to help you acquire a single multicolor image.

2.1 - Acquiring an Image 37
2.2 - Image Review and Editing 43
2.3 - Image Processing and Analysis 45
2.4 - Conversion to Experiment Mode 47
2.5 - Additional Acquisition Options 51
2.6 - Best Practices 54

Quick Start Instructions

Click theManual Mode button on the main menu
toolbar

or

open the Task Manager (if necessary)

1. Select Imager Manual Mode.

2. Select Capture now. The “Load Plate” dialog will open.

3. Put your plate on the carrier/stage and select its Plate Type (created in 1.2 - Important Gen5
Imaging Concepts as shown on page 6). The Manual Mode window will open with a live view of
your first well.

You may hear the objective turret turn and the stage move— this is normal.
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2.1 - Acquiring an Image

Manual Mode comprises 4 primary sections:

1. Navigation

2. Exposure

3. Focus

4. Acquisition

See also 3 - Advanced Acquisition Guide on page 58.

Gen5 v.3.11 adds confocal imaging capability to support this new imager line. We distinguish imaging
methods as “confocal” and “widefield.”
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Basic Acquisition Steps in Manual Mode

1. Pick theMagnification (objective). Confocal imaging requires a 20X, 40X, or 60X objective.
Selecting one of these objectives enables the choice of a confocal disk or, alternatively, Wide Field,
for widefield imaging.

2. Select the first Channel (or light source for the upright imager) to use, and navigate to the area of
the plate to capture.

3. Widefield imaging: Click Find Image. Gen5 automatically exposes and then focuses on the well.
This may take several seconds.Confocal imaging: manually set the focus height and exposure
settings for faster results.

4. For both methods, if necessary, use the Auto Expose and Autofocus controls to slightly adjust the
settings until you are satisfied with the quality of the image, going back and forth between expose
and focus.

5. Click the camera to capture the image. Then, you can change the color/channel and repeat
the capture steps.

6. When you have captured the images you want to save or analyze, click Process/Analyze.
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1. Navigation

Inverted Imager: Pick the Objective and
Channel from the objectives and fluorescent
cubes installed or Bright Field, Color Bright
Field, Phase Contrast, as applicable.

Upright Imager: Pick the magnification and light
source.

Find Image button: Gen5 iteratively applies
autofocas and exposure settings when you
select Find Image.

Click “Find Image” in widefield imaging with the
inverted and upright imagers. It is not
recommended for confocal.

Confocal Imager:

1. Set magnification to 20X, 40X or 60X.

2. Choose a disk, (not Wide Field).

3. Select the confocal filter cube.

Best confocal disk choice (for Cytation C10
“C2” models):

l 60 µm for faster imaging and less
photobleaching.

l 40 µm for better z-resolution for 20X/40X
objectives (with longer exposure time).

39

2 - Quick Guide to Imaging



You can navigate within the well using:
l the joystick, if equipped,

l the arrow keys,

l your mouse to click directly in the well map
(field-of-view) area

2. Exposure Controls

Best practice: Capture images with the lowest possible exposure settings for the best
analysis results. While human eyes prefer higher exposure images, software prefers
lower exposure images. After acquisition, use the Brightness and Contrast control to
improve viewing the image.

Note: The light source for confocal imaging is the LDI laser accessory. The imager controls the laser’s
intensity levels, in lieu of a Gen5 control option.
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3. Focus Controls

The focus controls help you position the objective
for the best image acquisition.

l If images are not at the desired focus, try increasing the Exposure settings, and expand the Focus
panel to run FM Scan. When you find a good peak, click the Set Focus Height to Max FM Ratio
button.

l If necessary, use the Auto Expose and Autofocus controls to slightly adjust the settings until you
are satisfied with the quality of the image, going back and forth between expose and focus.

41

2 - Quick Guide to Imaging



4. Acquisition Controls

The camera button captures the
image with the current settings.

Click Process/Analyze after capturing
images. Gen5 will save the collection of
thumbnails and present them for processing
and analysis as you proceed.
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2.2 - Image Review and Editing

Before processing and analysis, you can review the images, adjust the brightness and contrast to
improve their appearance, annotate the image, and save it for presentation. Thumbnails in the bottom
panel represent acquired images: click to select them for review.

Brightness & Contrast (B&C): Click Brightness & Contrast to adjust the
brightness and contrast of the image for optimal viewing. Click the Channel
arrow in the control to close it. Adjusting B&C does not affect image analysis;
it merely improves the display for the computer monitor.

Choose Auto to let Gen5 make the adjustments. Select Neutral to restore
the image to its original state.

Channel properties: To apply transparencies and/or adjust color gradients
to improve the image, click Channel properties in the B&C control.
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Annotation Toolbar

1. Show image in full screen

2. Change zoom to see entire image

3. Zoom to 1 screen pixel per 1 image pixel

4. Zoom tool: draw a box on your image to zoom in; right-click to zoom out

5. Hand scroll tool: click and drag to move your image

6. Line profile tool to draw a line through your image to see relative intensities

7. Common annotation tools to draw polylines, rectangles, and circles, apply text, and call out regions
of interest

8. Measure tool to determine size of objects of interest

9. Grid tool to turn custom grid on and off

10. Shift channels to overcome offset and improve overlay

11. Export image or metadata to Excel

Tip: you can also use your mouse wheel to zoom in and out.

Learn more: 6.1 - Annotation Tools as shown on page 141.
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2.3 - Image Processing and Analysis

Image processing and analysis in Manual Mode can be performed after image acquisition:

select Process/Analyze.

See 7 - Basic Image Analysis on page 148 to learn more.

Image Processing

Gen5 presents context-sensitive processing options. Generally, they work best when applied in the
sequence provided.

1. Click an option in the Add Processing Step
box.

2. Keep the default settings initially: click OK; you
can change the settings later if necessary.

3. Use the processed image in Image Analysis
(in the next step).

Gen5 creates a new data set for the processed
image. You can compare the two by selecting them
in the Image History box.

Double-click the processed data to modify its
parameters.

Image Analysis

1. Click Analyze to move to the analysis step.

2. Click Cellular Analysis.
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3. Select your Detection Channel and click Start.

4. Use the Line Profile tool and draw a line to get
thresholding and object size parameters.

5. Click Options (under the Start button), enter your
settings, and click Apply (and OK to close the dialog).

6. Gen5 returns to the previous window, and updates the
results displayed in the Image results and Object
details tables on the right.

7. At the bottom of the screen, click Add Step to save
the analysis (or Apply Changes if the step was
previously saved).
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2.4 - Conversion to Experiment Mode

Once you’ve acquired an image with optimal settings and applied processing and analysis steps as
necessary, you can easily convert the settings for that image to Experiment Mode, which
automates acquisition of multiple samples, for example, a chamber well slide or multi-well plate.

1. In Manual Mode, select the image of
interest.

2. Click Create experiment from an
image set button.

3. Then, you can click Read New
to begin acquisition.

Alternatively, to edit the protocol, see
below.

To Edit Your Experiment

You can make changes to your experiment after conversion. The most common changes will be:

A. Selecting wells of interest

B. Changing the autofocus method
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A. Selecting wells of interest

After converting your Manual Mode session to an experiment, open the read step to make changes:

In addition, if it will improve your assay, you can add activities (steps) to your Procedure by clicking
them. For example, add “Set Temperature” to turn on incubation. Drag and drop steps in the list to
change their order.
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B. Changing the Autofocus Method

Gen5 offers 5 image-based autofocus methods and a 6thmethod, Laser Autofocus, which requires
purchase of an optional accessory.

l Image-based autofocus methods take a series of images in a range of z-planes in search of
maximum contrast.

l Laser autofocus shines an infrared laser at the bottom of the well to locate the vessel-liquid
interface.

By default, Gen5 will use “Autofocus with optional scan” for fluorescent channels and “Bright field
autofocus (dual peak)” for bright field and phase contrast.

See 5 - Understanding AutoFocus on page 124 for a detailed discussion of Autofocus methods .

49

2 - Quick Guide to Imaging



To change the autofocus method:

By default, Gen5 uses the focal plane of Channel 1 for Channels 2-4. We therefore recommend making
your strongest signal as Channel 1. If you anticipate that your channels will NOT have the same focal
plane, click Focus options under your subsequent channels. You can either:

l Build in a defined offset from Channel 1 by typing a number into the Offset (μm) field.

l Autofocus separately on your other channels.

l Laser AutoFocus is recommended for most confocal experiments.

Watch thisManual Mode to Experiment Mode Training Video.
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2.5 - Additional Acquisition Options

The Imaging Mode panel in Manual Mode lets you define additional options for image acquisition,
including:

l Kinetic Imaging: to capture live
biology in real time or set up time-
lapse imaging.

l Dispensing: if the optional Reagent
Injector accessory is set up,
dispense steps can be built into your
assay.

l Advanced Imaging: to acquire
single vs multiple images in the x/y
(Montage) or z (Z-Stack) plane.

l Crop Image to Well: Eliminate
edge effects in microplate wells, and

enable feature.

Single Image Set – A single field
composed of a single x-, y-, and z-
coordinate. Can be captured in up to 4
colors, including phase or bright field.

Image Montage – A field composed of
multiple images (2-2000 images) that
can be compiled (stitched) to provide a
larger field of view (within a single z-
plane). Tiles can be stitched together in
Processing.
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Image Z-Stack – A field composed of
single x-/y-coordinates captured at
multiple z-planes (up to 200 slices),
down to 0.1 μm thickness per step. A
single image, called a Z-Projection, can
be created from these images during
Image Processing.

See 3 - Advanced Acquisition Guide on page 58 for a detailed discussion.

More Manual Mode Options

Binning

Expand the Focus panel to apply binning to your
image captures.

See Binning Options on page 86.

Expand the Stage Movement panel to change
these default settings:

l Adjust X/Y step size slider on the Stage
Movement panel to customize the degree of
movement when using the well map.

l Move carrier on mouse click: lets you pick the
focus area with a mouse click in the well map
or displayed image. Enabling the joystick
disables this option.

l Keep plate in instrument on exit: overrides
Gen5's normal behavior to eject the plate
carrier after every read.
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When you have an in-focus and properly exposed
image of the sample, expand the Count and
Confluence panel to perform an on-the-fly cell
count or confluence measurement.

Gen5’s “augmented microscopy” gives you instant
feedback to help you quickly assess the quality of
your sample. Click Options to use the same
background flattening, image smoothing, and
threshold filtering offered in Cellular Analysis to
apply a nuclear mask to count cells and/or
measure confluence in live mode.

Movie Maker

Expand the Control panel to change default
movie-making settings.

Cytation and Lionheart “W” models:

Available on the Control panel: Drop list of options
to capture images in Standard-size field-of-view;
Crop 75%, or Full WFOV.
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2.6 - Best Practices

Search for app notes and other resources at:
www.biotek.com\applications

Recommended microplates:

l Agilent 96-well clear 204624-100

l Agilent black with clear bottom 96-well 204626-100 and 384-well 204628-100

l Greiner µClear TC-treated 655090 96-well & 781091 384-well black polystyrene

l Greiner µClear cell-repellent 655976 96-well & 781976 384-well black

l Greiner 655892 96-well & 781892 384-well glass bottom

l Corning 4850 96-well half-area and 4851 384-well glass bottom

Get best image quality when using high-power objectives using glass-bottom plates. Oil and low WD
objectives require glass vessels.

Important: Make sure your Windows “Display setting” is at 100% for the best viewing experience.

To prevent media from sloshing or spilling, especially for cells in suspension
in low-density plates, you can slow down the plate carrier to avoid
disrupting vessel contents. For instruments that support it:

l In imaging manual mode, set the option on the “load plate” screen.

l In experiment mode, enable the slower speed in the Procedure>Options dialog.

l Enable or disable the setting using the Instrument Control panel (or via the System menu).

Setting Exposure for low signal samples: The best practice for analysis is to capture images with
the lowest possible exposure settings. While human eyes prefer higher exposure images, software
prefers lower exposure images. With low signal media, it is easy to overexpose the image, especially
when using WFOV cameras, where illumination correction may reduce the available intensity signal
range at higher exposures.

When using a “W-model” imager, instead of using Full Wide FOV to set the exposure settings, use the
drop list to select Standard FOV or Crop 75% for a good way to choose optimal exposure values. You
can reset to Full WFOV before capture.

After acquisition, use the Brightness and Contrast control to improve the image’s appearance.

In manual mode, expand the Control panel to access FOV
drop list. In experiment mode, find the options next to Magnification in the Image Read step.
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Fix Focusing Problems

Define your vessel’s “Bottom Elevation”

See Setting the Bottom Elevation on page 11: Gen5 uses the "bottom elevation" as the starting point for
autofocus. It is essential to correctly define the bottom elevation for the vessel and samples you are
imaging.

Adjust the Correction Collar

See Adjusting the Correction Collar on page 15: when using high-magnification objectives, 40X and 60X
(air), make sure the objective's "correction collar" is properly set for the plate type you are using.
Likewise, make sure other “plate type” settings, like the “accessible bottom focus region” match the
vessels you are using.

Try a different Autofocus method

Review the options for autofocus to determine if an alternate method is a better choice for your
application. See 5.1 - Autofocus Methods on page 125.

Adjust Auto Exposure parameters

De-select “Prioritize speed over image quality.” Integration
time will be increased, typically resulting in a better image.

Manual mode: open the Imaging Mode panel, select
Advanced options. Experiment mode: click Focus
Options.

Still blurry? Change the Target exposure %

l If the signal is relatively uniform across the image: decrease to 25-50%.

l If the image intensity is highly variable: increase to 80-100%. This will force the focus algorithm to
target dimmer objects and ignore bright objects, which may be impeding focus.

Use Dynamic Histogram to Set Exposure

Use Gen5's dynamic histogram during image acquisition to
determine the best exposure settings. The histogram updates as
you select different exposure settings, giving you instant
feedback on the effect of your choices. See Histograms on
page 60.

After acquisition, use the Brightness and Contrast (B&C) controls
to improve online viewing.
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Plating, Incubating & Handling Cell Plates

Find app notes and other useful info at Agilent's:
www.biotek.com/applications
Agilent provides guidelines in an app note titled: Automated Tissue Culture Cell
Fixation and Staining in Microplates.

Many factors influence fluorescence imaging and image analysis data quality, including one of the most
critical factors: good sample preparation.  A fluorescent image is the raw data for an experiment, so close
attention to the details in sample preparation significantly improves the assay results.   

Make sure your cells are properly plated (i.e., 40-70% confluent).

n Cell Plating

l After plating cells, allow them to sit on the lab bench 15 to 20 minutes prior to incubation
to give cells time to settle more evenly, reducing uneven distribution within wells and
minimizing edge effects.

n Cell Growth

l Do not stack plates in an incubator to avoid uneven heat and humidity distribution that
increases plate-to-plate variation.

l Keep plates away from the incubator door, which is often heated, creating additional edge
effects in the wells.

n Compound Addition

l DMSO: Cells can typically handle a final concentration between 0.25-1% DMSO (cell-type
dependent). Dilute the solvent and mix thoroughly to avoid variability caused by
inadequate mixing.   

l The main source of false positives in many screens involves auto-fluorescent compounds.
Visually confirming images in hit wells is recommended to ensure the hits are not caused
by auto-fluorescent compounds. 

n Example of red auto-fluorescent compounds: Doxorubicin and Epirubicin.

n Reagent Addition

l Warm fixatives and reagents prior to additions to decrease cell stress.

n Condensation on Plate Lid/Seal

l Apply a temperature gradient when defining incubation
settings to prevent condensation forming.

ll To add a temperature gradient to your Experiment, open the
Procedure window and add a Set Temperature step. Here
you can add a 1-3ºC gradient.

n Imaging Microplates

l Clean the bottom of the microplate or slide surface prior to imaging. Remove any
condensation from the bottom of the plate with a lint-free cloth.
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l When imaging a previously stained plate that is stored at 4ºC, allow the plate to warm to
room temperature; otherwise, the plate bottom collects condensation that causes
blurred images.

l Select the correct microplate in Gen5; selecting the wrong vessel causes autofocus
failures due to incorrect Plate Type dimensions.

See also Speed Up Focusing Process on page 130.
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3 - Advanced Acquisition Guide

Tools to Optimize Your Assay

Once you’ve become comfortable with basic acquisition in Manual and Experiment Modes, Gen5
provides a variety of ways to improve your settings to best optimize your assay and acquire more
complex images. In this section you will find:

3.1 - Optimizing Exposure Settings 59
3.2 - High Contrast Bright Field (HCBF) 62
3.3 - Image Montage 64
3.4 - Z-Stacking 72
3.5 - Kinetic Image Capture 79
3.6 - High Power and Oil Objectives 89
3.7 - Plate Definition and Labware 92

58



3.1 - Optimizing Exposure Settings

Exposure relies upon 3 variables for widefield imaging: Illumination or LED intensity (light brightness),
integration time (length of exposure), and camera gain (digital amplification of signal). For confocal
imaging, light is provided by the accessory LDI laser and controlled by the imager. Only integration time
and camera gain controls are provided in confocal imaging.

Each has its own benefits and drawbacks, as outlined below:

Exposure Parameter Benefit of high setting Drawback of high setting

1. Illumination (widefield only) Sensitivity Photo-bleaching

2. Integration time Higher image quality Significantly slower imaging speed

3. Camera gain Faster read speed Lower image quality

In addition to the Auto Expose options, sliders for the variables allow the user to achieve a well-exposed
image while accommodating for the specific requirements of the assay, for example, compensating for a
photosensitive reagent by reducing LED intensity and integration time, but increasing gain. These sliders
are present for all imaging modes except Color Bright Field.
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Bright Field and phase contrast use
transmitted light to image samples,
rather than the LED-Filter cubes used in
widefield fluorescence imaging.

As such, light illuminates the sample
from above, making these modes only
compatible with clear lids.

Watch this Image Exposure Settings Training Video.

Histograms
In addition to the visual cues in the live image, the image histogram can provide additional information for
fine-tuning exposure settings and maximizing use of the camera’s dynamic range. Histograms display the
relative quantity of pixels of a given intensity level (from black to white) of all pixels for the current image.
The x-axis shows the pixel intensity values, and the y-axis provides a count of pixels at each intensity
level. The greater the number of pixels in the image at a specified intensity level, the higher its peak in
the histogram.

Gen5 displays an image
histogram in two y-axis scales,
linear and logarithmic. The
black (or dark) plot uses a
linear scale and the gray (or
lighter) plot uses a logarithmic
scale.

When capturing an image, the image histogram can verify that the camera’s dynamic range is being used
effectively. Overexposed images have a peak at the far right, illustrating an accumulation of pixels that
have saturated the camera’s dynamic range. Underexposed images show the majority of pixels
accumulated on the left on the histogram. 
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Underexposed
image and histogram
of DAPI stained cell
nuclei. The histogram
does not use the full
dynamic range and
there is
correspondingly poor
contrast in the image. 

Overexposed image
and histogram of DAPI
stained cell
nuclei. Note the loss of
texture detail in the
saturated nuclei.  

Properly exposed image and
histogram of DAPI stained cell
nuclei. Note the retention of texture
detail in the nuclei in the image and
use of the full dynamic range in the
histogram without over- or under-
exposure of pixel intensity.  
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3.2 - High Contrast Bright Field (HCBF)

Requirements: Lionheart FX, Cytation 1, Cytation C10, Cytation 5 (phase contrast models only: CYT5MPV
or CYT5PV), Cytation 7 (“W” models), and Gen5 Image Prime or Image+ software. Not supported on
Cytation 3. Lionheart FX and Cytation 5 instruments require the purchase and installation of an optional
accessory provided by Agilent. Cytation C10 requires installation of the accessory but it is provided with
the imager.

Significant improvements to cell counting have been seen when using a custom aperture in bright field
imaging, for certain instrument models. This simple modification yields high-contrast images of adherent
cells that can be easily counted by Gen5. The HCBF aperture needs to be installed and the .xml file for the
4x objective imported before image capture (follow installation instructions provided with the kit or
operator’s manual).

The custom aperture is not needed for the Cytation 1 and Cytation 7 imagers, as these instruments are
equipped for high contrast bright field (HCBF). Cytation 7 imagers have a manual switch to engage
HCBF: lift the top door and move the switch to High Contrast.

Image Capture
Images can be captured in either manual mode or experiment mode.

Defocusing for Better Contrast

Slightly defocusing the bright field image is recommended to improve cell counting. Usually this is an
iterative process of trial and error to determine how to achieve the highest contrast while retaining
acceptable focus.

1. First, find the optimal focus settings.

2. Then, defocus the image by reducing the "Current position" by a starting point of -250 µm (in manual
mode).

3. Use the Line Tool after defocusing to evaluate the setting's effect on separating background and
foreground signals. Your goal is to find well-defined intensity peaks for defocused cells.
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image before defocusing image after defocusing

Manual Mode Experiment Mode

After finding the best focus position, click the
position button and subtract 250 µm to
"defocus" the image (for example: 3263-
250=3013). Evaluate the results of this
defocusing and fine-tune the setting as
needed.

Perform two Bright Field reads, one "in focus" for
the best images and one "defocused" for the best
cell counting. For the second channel, select Focus
options. Select Focal height from first channel
(+offset), and enter a defocusing Offset.

Better results have been observed in high-contrast cell counting in
wells with severe meniscuses by disabling Gen5’s “illumination
correction” feature.

If this type of meniscus effect occurs, de-select Perform
illumination correction.

Watch High Contrast Brightfield Training Video
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3.3 - Image Montage

Montaging allows you to capture a larger field-of-view while maintaining the resolution of your desired
objective. Montage is a good choice when:

l Many cells are required for analysis

l Large objects contain information beyond a single field-of-view

Gen5 supports acquisition of up to 2000 images (tiles) in a single field, which can be processed, stitched,
and analyzed individually or as a single final image.

For Image Stitching, Gen5 Image+ or Image Prime software is required.

Montage in Manual Mode

Expand the Imaging Mode panel.

EnableMontage. Navigate the field-of-view with the software controls or the joystick, and set the
boundaries: Set Top, Set Bottom, Set Left and Set Right.
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Red lines will appear on the well map as you
set boundaries. When finished, you will see a
red box indicating the area to be covered by
the montage.

After defining the area you want to
capture, click the camera button. The default
"Auto for stitching" setting gives 10% overlap
between tiles.

Best practice: set boundaries as close as possible
to the edges of the object of interest.

After defining the capture area for a montage in manual
mode, you can edit some of the parameters, including
the Tile Overlap for stitching.

Montage in Experiment Mode

In the Procedure,
create an imaging
read step and select
Montage.
Adjust the number of
rows and columns to
define the capture
area, which will be
shown in the well map.
If the entire well is
desired, you can click
onMontage entire
well.
You can also define
offsets for the
montage center or
use beacons (covered
in 4.3 - Beacons,
ROIs, and Offsets ).
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Gen5 offers 3
methods for tile
overlap. By default,
Gen5 applies “Auto
for stitching,” which
determines the
overlap based on
objective size. This
creates an optimal
amount of common
information between
images (indicated by
dotted lines) to create
a seamless final
stitched image.

Alternative options
include:

No Overlap: Images
touch, but have no
common areas.

Custom: You can input values for column and row separation. Positive values
increase the overlap; negative values spread the images out, as shown here.

Objects in a stitched image based on a montage
with no overlap may appear jagged and

distorted, and a single object may even appear
as multiple objects.

For example, in the image at right, Gen5 would
count 8 objects:

Gen5 would count 8 cells in this
“No overlap” montage.
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Applying an overlap is recommended for higher
quality stitched images. Gen5 uses a cross-

correlation method to blend individual tiles into
one smooth image.

In this case, the final stitched image will look like
this image and only 4 objects would be counted:

Gen5 would count 4 cells in this
stitched montage.

Watch thisMontange in Manual Mode Training Video.

Viewing Montage and Stitched Image

Viewing Individual Tiles
After capturing the montage image, Gen5 presents a
special Control box to let you view the whole raw image
(unstitched) or an individual tile:

l All positions: click this button to display the entire
montage.

l Click a tile in the control to display that segment of
the montage. Each tile represents a tile in the
montage.

Note: the Montage Control is only presented when the
raw montage is open. It closes when a stitched image is
being viewed.
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Navigation tools: Depending on the number of tiles, the Navigation panel in manual mode, and when
processing or analyzing images, will vary from buttons to spinners for selecting tiles.
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Image Stitching
Image Stitching, or creating a single image from
montage tiles, can be found under Image Processing
in both Manual Mode and Experiment Mode. Refer to
section 2.3 - Image Processing and Analysis as shown
on page 45 for Manual Mode instructions or section 6 -
Image Processing as shown on page 138 for
Experiment Mode instructions.

l Registration channel is the channel that will be
used to determine the tile alignment. Choose the
channel with the most signal and coverage, often
this is your nuclear stain.

l Fusion Methods are algorithms to stitch images
from a montage into a single image. Each option
refers to a method for resolving the overlapped
pixels.

l Crop stitched image to remove black rectangles
on the borders crops the final montage to align
with the area of most coverage. As tiles are
aligned into a montage, some require more
shifting to generate a seamless overlay with its
neighbors. If this option is left unchecked, the
remaining area will be filled with a black box.

l Fill gaps between tiles with local background color
examines the 4 nearest pixels that have a valid
intensity and averages these values to estimate
the local intensity; and, uses this intensity to fill
the gaps.

l Downsize stitched image reduces the final image
size. A full-resolution image will be (2.2 MB
[minimum size of each tile] X number tiles in the
montage). Downsizing improves computer
performance and storage space, but also reduces
the resolution of the resulting montage.

Important: The pre-downsized stitched
montage must be less than 4096 MB.
Stitched images (after downsizing) must
be smaller than 1 GB (1024 MB).

Linear Blend is typically the most
effective fusion method, and the default
choice. You may want to experiment with
the other methods to confirm the best
option for your needs.
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Exclude Unwanted Tiles
"Mask" tiles to exclude unwanted areas from the stitched montage and analysis results.

1. Select the unstitched montage in the Image History box in
manual mode, or the raw image set in an experiment.

2. Select the tile you want to mask by clicking in the image or using
the Navigation tools.

3. ClickMask. Gen5 marks the tile with a red X.

Gen5 prompts for an audit-trail comment when a mask is applied.
A "Good Laboratory Practice" (GLP) is keeping notes on the
reasons for the mask.

Fixing Montage/Stitching Problems

Poor Cross-Correlation

To correct "poor cross-correlation" in a stitched image,
define a Custom tile overlap in the read step. Select:

l Edit Imaging Step in manual mode,

l Read Step in experiment mode.

Auto for stitching: by default Gen5 defines a 10%
overlap or 75 μm, whichever is greater.

Custom: lets you specify the tile overlap. Increase the
overlap to 20-30% to avoid poor cross-correlation.

Note: Gen5 may display a "poor cross-correlation"
message even when stitching is perfect. When
Gen5 detects two or more blank tiles with nothing
crossing between tiles, it reports poor cross-
correlation.

Sample of stitched image with poor cross-
correlation
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In the stitched image above with the poor
cross-correlation results, the montage images
(tiles) were taken with a 10% overlap.

When the images were taken with a Custom
20% overlap (shown left), Gen5 generated the
same stitched image with smoothed
transitions between tiles.

Montage Takes Too Long?

Click Advanced options at the bottom of the Read Step (in Experiment mode) or Edit Imaging Step (in
Manual mode):

1. Reduce the Delay after plate movement setting.

2. Turn on Only autofocus on center of montage.

Typically these changes save 30-40 minutes on a 3-hour imaging read.
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3.4 - Z-Stacking

Z-stacking captures multiple images in multiple z-axis (or focal) planes. Use Z-stacking when analyzing:

l thick samples like spheroids and tumoroid colonies,

l hanging-drop assays,

l whole organisms like zebrafish and C.Elegans,

l assays run in matrigel, like angiogenesis and tube formation.

With these types of samples, multiple images (up to 200 slices) must be acquired by moving the objective
in the z-axis with a step size of 0.1 µm or greater. After acquisition, Gen5 lets you view, analyze, and save
individual slices (images). Gen5 can also combine the slices (or a subset of slices) into a "Z-Projection."
Z-projections can be processed and analyzed as a single image.

Recommendation: First use Manual Mode to determine the optimal parameters for acquiring a z-
stack of your sample. Then, apply those parameters in an experiment (Experiment Mode).

Watch this Z-Stack Image in Manual Mode Training Video.

Capturing a Z-Stack

Good to know before you begin:

l In both manual mode and experiment mode, Gen5's starting point for a z-stack acquisition is the
Bottom Elevation of the selected plate type. Make sure your vessel's bottom elevation is correctly
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defined: See Bottom Elevation: on page 1.

l Gen5 defines the capture height of the z-stack as the "sample thickness."

Manual Mode Z-Stack

Focus Controls

1. After selecting the magnification and color channels or light
source; apply binning, if desired, on the Focus panel; and set the
exposure or Auto Expose.

2. Use the Autofocus control buttons (shown above) or the
joystick (not shown) to find the Top or Bottom z-axis position that
best defines the start of the sample area you want to capture.

3. Expand the Imaging Mode
panel and enable Z-Stack.

l Gen5 always shows the current Z position as you move in the z-
axis.

When you define the capture
height for a z-stack,

Gen5 determines the Sample
thickness.

Step size is set by the objective.
4. Click the Set button for each position when you have found the

lowest and highest in-focus images of the sample.

5. Click the camera button to capture the Z-stack.

Edit the imaging step to
review/change the number of

slices.

Based on your capture height and the objective depth-of-field (or step size), Gen5 determines the
sample thickness and sets the number of slices required to capture the whole sample.

You can use manual mode to determine the best parameters and then save them in an
experiment, click Create an experiment from the image set.
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Experiment Mode Z-Stack

To define a Z-stack directly
in experiment mode, set:

l Step size: defaults to
the depth-of-field of the
objective; it can be
changed if needed;

l Number of slices:
defines the Sample
thickness.

l Focus point: by default,
the Bottom position is
the focus point. You can
use the slider or the
number of Images
below focus point to
define an alternative
capture range.

Flexible tools for defining the capture height for a Z-stack

Viewing a Z-Stack

After capture, Gen5 presents a Z-Stack Control. You can use:

l the slider or the Height scroll buttons to display one slice at a
time in sequence,

l Z-Stack Slide Show: to view the slices like a slide show:

l

Z-Stack Movie: click the record button to make a movie.

l

3D Viewer: click the to render the z-stack in 3D. See 3D
Viewer on page 76.

well zoom or manual mode

In experiment mode, set the plate's Matrix
Data to "Picture" without a ZProj label to open the Z-Stack Control and view the individual slices.
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Creating a Z-Projection
Gen5 Image+ or Image Prime software required

After acquiring a z-stack, Gen5 can
combine the slices (images) into a 2D
rendering or Z-Projection. All or a
selected subset of the slices in the z-
stack can be included in the projection.

To create a Z-Projection:
l In Manual Mode, click Z
Projection in the Image
Processing area (shown right).

l In Experiment Mode, define a Data
Reduction step.

Manual Mode

Before or after defining a Z-Projection, Gen5 lets you try to
improve image quality with preprocessing and/or
deconvolution. After creating the projection, you can
analyze the image.

When combined with a montage, Image Stitching must be
done before making a Z-Projection.

Specify Method and Slices for Z-
Projection

1. In the Z Projection window, select
a color Channel. For a multi-
channel z-stack, click the + tab for
each additional color. Gen5 will
supply any subsequent channels.
By default, they are set to "Use
settings of channel 1," but you can
change the settings for each
channel individually.

2. Select a Method. For most assays,
the Focus Stackingmethod is
best. It includes only in-focus
images in the projection.

3. Use the Top and Bottom slice scroll
buttons or drag the slider to limit
the projection to a subset of slices.

Create multiple Z-Projections, each using a different
method, to quickly evaluate the results of each method and
choose the best one for your samples.
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Gen5 can perform image analysis on the Z-Projection in both manual and experiment modes. The Z-
Projection is treated like any other single image.

Troubleshooting:

l Z-Projection Focus Stacking: When using the Focus Stacking method to make a z-projection,
you can adjust the “Size of Max. filter” to improve the output. Filter size is sample dependent:
generally, the smaller the objects of interest, the smaller the filter size should be, and conversely,
the larger the objects the larger the filter size.

l Acquiring a Z-Stack: (for inverted imagers) Make sure all your objectives and LED and Filter
Cubes are calibrated if you experience problems capturing z-stack images. Select
System>Instrument Configuration. Double-click the imager item and click Setup. Click the
Imaging Configuration tab, and rerun Auto Calibration. This may take several minutes to
complete.

3D Viewer

Requires Gen5 v.3.11

For z-stacks captured in fluorescent channels, Gen5 provides the
3D Viewer. Click the 3D Viewer button in the Navigation tools to
launch the viewer.

Good to Know:

l Transmitted light captured images, e.g., brightfield, are not supported. However, images captured
in both fluorescent and transmitted light can be viewed in the fluorescent channels only.

l Z-step size affects rendering. Smaller step sizes produce better images. Rule of thumb: divide
Gen5’s default step size by 3. However, be conscious of file size when employing the setting, as
extremely large file sizes create a data management challenge.

l

Dim or low signal channels can sometimes obscure the rendering of bright or high
signal channels in multichannel images. If part of the image appears blank, try toggling visibility by
de-selecting dark channels to improve the view of other channels in the image.

l High performance computers are recommended for the best experience using the 3D Viewer.
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Interactive Controls:

Several controls for manipulating the 3D projection are provided. Experiment with them to determine
the best rendering of your sample.

Begin by applying the bounding box to enhance the 3D dimensions.

Toggle the X, Y, and Z planes to add these views to the projection, if useful.

In addition to the toolbar buttons, you can use your mouse to:

l Zoom into and out of the projection using the mouse wheel.

l Press and hold Ctrl while using the mouse to rotate the projection on its center axis.

l With an X, Y, or Z plane visible, click and drag the plane to view it in grayscale at various positions
in the stack. Right-click and drag on the plane to change its brightness and contrast.
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Use Histograms to improve projections:

Histograms for each color channel are interactive in the 3D
viewer. The X-axis displays intensity, Y-axis displays
number of voxels.

De-select a channel to hide it.

Click and drag the black and white pointers at the top of
histogram to adjust the intensity and number of voxels.
Click Auto or Auto Adjust All to restore the pointers to
their original positions.

Reset Allmoves the white pointer to its maximum setting
and moves the black pointer to its minimum setting.

The bottom bar of the histogram shows the color of voxels
in the rendering.
Consider using the Display Load Options to improve the
projection by reducing the number of slices included.
Downsizing may also reduce file size for better
performance.

3D Snapshots and Movies:

Use the controls at the bottom of the 3D Viewer to
capture snapshots and movies of the current 3D
projection. Snapshots can be saved as TIF or
JPEG.

Click the options button to customize the movie
settings. This is especially useful for reducing the
file size of the movie.
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3.5 - Kinetic Image Capture

Time-lapse image capture is available in both Manual and Experiment Modes. Several factors affect the
interval duration, including:

l Number of detection channels

l Integration time

l Autofocus method

l Binning (See Binning Options on page 86)

l Advanced imaging modes: Montage and/or
Z-Stack

Kinetics requiring a fast frame rate, such as Ion Channel Assays, can be performed when the signal-of-
interest has correspondingly rapid integration times. Integration times to achieve 10 frames-per-second
(fps) must be set to 50 milliseconds (ms) or lower; integration times to achieve 20 fps must be 20 ms or
lower (with binning turned on). Fast kinetics must be performed in Well Mode.

Watch the Kinetics Overview Training Video.

Kinetic Acquisition

Manual Mode 1. Expand the Imaging Mode panel, (Z-Stack
and Montage can be performed in a Kinetic
loop) and check Kinetic imaging and
Dispense, if applicable.

2. Click Edit Imaging Step.

3. Within the Well Mode loop, double-click the
Dispense and Start Kinetic steps to define
the dispense, interval (the time between
imaging steps), and total run time.

4. Click to execute the run.

Select Kinetic imaging and/or Dispense to enable
the Edit Imaging Step button:
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Important: The kinetic interval must be long enough to acquire the images.

Burst Rate: 10 frames per second (fps) at full resolution, 20 fps at 2x2 binning.

Save your manual mode settings to create an experiment. Otherwise, define a kinetic read step
as usual in Gen5's Procedure dialog.

Discontinuous Kinetics

Gen5’s most flexible kinetics option “discontinuous kinetics,” frees up the instrument so it can be used in
other experiments, during incubation or rest periods. Discontinuous kinetics also gives you the
opportunity to add reagents, or otherwise manipulate the plate/vessel in between reads (image
acquisition). Gen5 aggregates the measurements/images obtained from the multiple sessions, combining
them into one result set. It gives users full control of image acquisition, rather than relying on the
automated or programmed intervals of standard kinetic image capture. Discontinuous kinetics provides
all the kinetic analysis options of the standard kinetics, e.g., kinetic curves, Max V.

Note: Discontinuous Kinetics is required for BioSpa OnDemand protocols.

80

3 - Advanced Acquisition Guide



Set Up a Discontinuous Kinetic Experiment:

1. From the Task Manager,
select Protocols >
Create New (or create a
new experiment).

2. When defining the
procedure, select
Options, and select
Discontinuous Kinetic
Procedure.

3. Enter "estimated" time
points in
Days:Hours:Minutes:
Estimated total time and
Estimated interval. This
is just an estimate and
will not interfere with
actual experiment
activity. Gen5 uses your
estimated time lines to
set up the data views and
formulas with
placeholders until the
actual data is captured.
When in doubt about the
required time period and
intervals, it is best to
overestimate them.

4. Define the Read step(s) as usual, and save the protocol.

5. Create an experiment based on the protocol, and read the plate.

6. Save the experiment (and close the file, if desired).

7. Remove the plate and process (e.g., add reagent,
incubate, etc.) until it is time for the next reading.

8. Open the experiment, put the plate on the carrier,

click Read New, and select “Continue
reading.”

Gen5 compiles all the reads into a kinetic data set, and performs Data Reduction as defined in the
protocol.
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Kinetic Image Registration Options

Note: For fast kinetic assays, Kinetic Frame Alignment as shown on the next page is a better option
for improving image acquisition. Kinetic Image Registration slows down the process, capturing up to 5
additional images which could add as much as 20 seconds per frame.

Gen5 provides this feature to correct
some of the effects of incubation on
plastic plates and improve tracking of
cellular activity during time-lapse assays.
Image Registration performs X/Y
carrier adjustments between kinetic
image acquisitions. Registration
compares before and after images to
determine drift in either the x- or y-axis.
Then, corrects for any drift detected prior
to image capture by repositioning the
carrier.

Choose the reference image: either the first image captured in the kinetic time span or the previous
image captured.

l Register to first image: If you expect little change in the sample biology over the course of the
experiment.

l Register to previous image: if the biology is changing quickly, e.g., cell growth or phenotypic
changes.

l Registration success threshold: Enter a value between 0 and 1 (default is 0.25). This value
represents the threshold that the image registration must meet to be considered successful, with 1
being a perfect match and 0 being no match.
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If the normalized cross-correlation factor between the test and the reference image is below the
registration success threshold, the registration move is not made. In cases where image
registration is adjusting the position of the sample incorrectly, it may help to raise the threshold.

l Max move per kinetic loop: Optionally, you can specify the maximum distance the alignment
can move during each kinetic read.

Kinetic Frame Alignment

After executing a kinetic read, Gen5 offers an image processing step to improve the quality of a movie
made from the images. Kinetic Frame Alignment removes the X-Y movement between frames that
occurs naturally during image capture.

Manual Mode Experiment Mode

In Processing pane: Add a Data Reduction step:

or in a well zoom (from plate matrix), click Process:
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Before making a movie, perform this frame
alignment step, choosing options that produce the
best effect for your assay. Some experimentation
may be needed.

Then, choose the "Aligned(detection
channel)" data set as your movie source:

See Recording and Saving Time-Lapse Movies
below.

Recording and Saving Time-Lapse Movies

Gen5 3.00 (and higher) offers movie maker controls in both manual and experiment mode. Generally, a
kinetic or time-lapse acquisition produces the best results, but Z-stack and manual manipulation of the
imaging process can also be captured in a movie.

84

3 - Advanced Acquisition Guide



Manual Mode Experiment Mode

Click record during the session.

Click stop button to end recording.
Select Movie Options from the Control panel to
customize settings:

After you define and execute a kinetic read step
in Gen5, drill into a well zoom:

l Use the Quality slider to make the images
sharper or conversely to save disc space by
compressing the file size.

l Annotations made to the images will be
captured and saved in the movie.

l Kinetic acquisition is supported in manual
mode.

l Masked frames can be excluded from the
movie.

l Kinetic Frame Alignment: a special image
processing step can be applied to improve the
quality of movies made from a kinetic read.

Click the record button to open the controls:
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Saving Movie Files

Gen5 offers two file formats and several other options
for saving your movie files:

l .wmv is Windows default video file format

l .mp4 is an industry standard video file format

Note: Stitched Montage Movies: MP4 is limited to 9.4 megapixel images. WMV is limited to 12.3
megapixel images. If you try to record a video with a larger image resolution, like a stitched montage,
you may get an error message or the video may not be viewable.

Binning Options

Image binning can improve focus and acquisition speed. Binning is a method that combines intensities
from a 2x2 pixel grid into a single pixel. This reduces the image size and storage down to 25% the original
size. It also can reduce the integration time needed for exposure by a factor of up to ¼ because the
intensities of each pixel in the 2x2 grid are summed into the final pixel. Binning affects exposure settings:
binned images are brighter than non-binned images with the same exposure settings because pixel
intensities are doubled.

Manual Mode Experiment Mode

Define in the Procedure’s Read step

Gen5 offers two options for binning images: Autofocus and Capture, but binning must be “on” for
Autofocus to apply it to acquisition. You can test the binning effects in manual mode by enabling and
disabling the option and viewing the difference.

Advantages of Binning Disadvantages of Binning

smaller image file size reduced spatial resolution

potentially improved signal-to-noise ratio reduced image size (lower resolution)
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Advantages of Binning Disadvantages of Binning

faster performance - smaller integration

higher sensitivity, especially for red dyes

l Autofocus: Binning affects the exposure setting during autofocus. Gen5 adjusts the exposure
automatically to get the most intensity possible.

l Capture: Gen5 stores the resizing information (height and width number of pixels) with the image.
Generally images will be 1/4 size compared to non-binning capture.

Recommended practice when using binning: check and set the exposure settings in each channel
with binning enabled before acquisition.

Kinetic Z-Stack Montage

In Gen5 3.04 or higher you can combine the advanced acquisition methods. Combining time-lapse
imaging with z-stack and montage captures may be useful for multicellular assays, spheroid or zebrafish
imaging, for example. Such a complex image compilation will produce significantly larger data files
depending on the number of color channels, z-stack slices, montage tiles, and kinetic intervals. Consider
your file management needs before beginning this type of acquisition, e.g., can you save the files to an
external hard drive?

Gen5 supports up to 2000 images/channel/well or up to 8000 images/well. Keep this limit in mind when
defining the number of slices in the z-stack and number of tiles in the montage.

Important: The pre-downsized stitched montage must be less than 4096 MB. Stitched images (after
downsizing) must be smaller than 1 GB (1024 MB).

Manual Mode Experiment Mode
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Copy & Paste to add a Channel

In manual mode, Gen5 copies the live session settings for a color channel and lets you paste them into
the read step. To add another channel to the kinetic, z-stack, and/or montage read:

1. Click Edit Imaging Step. Open the Read step (inside the kinetic loop, if applicable).

2. Add a channel in the imaging step dialog and click OK to close the window.

3. Back in the Capture mode, select the additional channel and define its focus and exposure settings.
Note: Gen5 remembers the last parameters used for the channel.

4. When settings are defined, click the Copy button, and then select Edit Imaging Step.

5. Click the Clipboard button for the channel to paste the settings. When all the channels are
defined, click OK to close the Read step. Click OK to close the procedure window.

6. Click to start the procedure.
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3.6 - High Power and Oil Objectives

Focusing Suggestions for High Power Objectives
l Joystick: if available, use the joystick for the most precise controls for navigation and focus.

l Exposure controls: See 3.1 - Optimizing Exposure Settings on page 59 for more details. Except
for setting LED intensity, to gain more precise control of exposure settings, click on the slider and
then use your keypad’s arrow keys or your mouse wheel to more gradually increase or decrease
the settings.

l Reduce the Integration Time and increase Camera Gain, at least initially, when trying to find
the object of interest. Then, select Auto Exposure.

Important: See 1.5 - High-Power Objectives for important setup guidelines for high-power
objectives.

40X, 60X, and 100X Objectives: Limitation

96- and 24-well plate maps when using a high-power objective

Depending on the vessel, high-power objectives may not be able to capture images of all wells or
sections of the vessel. Keep this in mind when you are plating your samples. This limitation is visible
when selecting the wells to read in a read step (click the Full Plate button). On the contrary, the
limitation is not obvious when defining the Plate Layout.

Gen5 identifies this limitation in the plate map:

l X to show when no part of the well can be imaged;

l O to show when only a portion of the well can be imaged.

To view the plate map in manual mode, clickWell:
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To view the plate map in experiment mode:

1. Create a Procedure and select the Plate Type.

2. Click Read, and set Image as the detection method.

3. Set the Objective to 40X or 60X (phase/standard) and click Full Plate.

Oil Objectives

Lionheart only

The Lionheart supports the use of oil immersion objectives and Gen5 guides users through the process of
applying and removing the oil. The oil immersion objectives are optimized for viewing through cover-slip
thick glass, 0.17 mm, and do not have a correction collar to override this preference.

Olympus oil immersion objectives are available in magnifications of either 60X or 100X. The transparent
Olympus® Immersion Oil Type-F supplied with your objective has a high viscosity that produces an
uninterrupted liquid column between the two surfaces. It is not recommended to use other oil types.
Moreover, the oil is optically similar to glass with a refraction index of 1.515.

Requirements
l Use glass vessels:

l cover slips

l slides

l glass-bottom microplates and Petri dishes

l Manual Mode Only: oil objectives can only be used in live or manual-mode sessions, not
experiments.

l One well at a time: best practice to avoid spreading the oil on the vessel, image one well or slide
at a time.

l A single drop of oil: use as little oil as possible, typically a single drop is sufficient. You can
reapply oil as needed.

l Clean the oil after each application: clean the objective with lens paper after each image
capture. This prevents oil seeping into and damaging substage components. Also, clean the vessel
bottom.

l Note: Autofocus is not supported and Gen5 does not calibrate oil objectives.
Likewise, “Color Bright Field” imaging is not supported.

Procedure: Using Oil Immersion Objectives with the Lionheart

Instructions for installing oil immersion objectives can be found in the operator’s manual.

Oil loading and cleaning procedures are stepwise. You can execute them by using Gen5’s instrument
control panel or you can respond to prompts when you select an oil objective in manual mode. Best
practice is to follow the sequence as prompted to load oil and then clean the objective before switching
back to a non-oil objective.
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Control panel: When an oil immersion objective is installed, you
can open the Clean Objective wizard via Instrument Control
panel.

1. Select an oil objective.

2. Click the oil can to open
the wizard.

3. Follow the prompts,
clicking the buttons to
tell Gen5 which step you
are on.

Select Skip when
applicable to advance to
the next step. For
example, if there isn't a
plate on the carrier when
you begin, click the first
Skip button.

4. Be sure to clean the
objective after use.
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3.7 - Plate Definition and Labware

Choice of cell culture vessel significantly affects image quality and assay success, especially with higher
power objectives. If possible, choose the thinnest, flattest medium possible. Get the best image quality
when using high-power objectives by using glass-bottom plates. Oil and low WD objectives require glass
vessels. Best choice: glass or optical-bottom plates, like these:

Recommended microplates:

l Greiner® µClear TC-treated 655090 96-well & 781091 384-well black polystyrene

l Greiner µClear cell-repellent 655976 96-well & 781976 384-well black

l Greiner 655892 96-well & 781892 384-well glass bottom

l Corning® 4850 96-well half-area and 4851 384-well glass bottom

l Corning 4520 ULA microplates for spheroids

The proper plate definition for your vessel is also crucial to achieving the best possible results. At its most
complex, you can create custom layouts, including wells within wells (see Custom Labware in this
section); however even the most basic plate definition requires properly defining the Bottom Elevation
and Bottom Thickness (as described on page 1).

1. Select System>Plate Types.

2. Find the Plate Type you are using and click View/Modify. “Default plate types” cannot be modified:
you must Copy them and create a new plate definition with a unique name.

3. Click Imaging Parameters.

4. In the Plate Description – Imaging Parameters window: make sure that Define Bottom Focus
Region is checked to establish exclusion zones and prevent objective collisions with the carrier, and
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click .

5. At the prompt, place the vessel on the imager’s carrier or stage and click OK.

6. Select your objective and LED filter cube. Use the strongest wavelength for your samples, (i.e., GFP
or DAPI).

7. Accept the default well selected, A1, or choose another well to take measurements at various parts
of the plate (as described below).

8. Run Auto Expose and then FM Scan. When you get a defined peak: click Set Focus Height to
Max FM Ratio.

9. Click Save Settings. Gen5 will update the Bottom Elevation value.

Correct for Variability Across the Plate

Plastic tends to warp especially when placed in an
incubator; this may cause a high amount of
variability across a microplate. For example, a
200-1000 µm difference between A1 and D6 in a
96-well plate is possible. Lower density vessels
(e.g., 6-well plates) also have a large amount of
variability across the bottom of the plate.

If you are seeing an image focusing problem
across your plate, take 2-4 more measurements in
the corners and the center. (In step 7 above select
each of the four corners: e.g., A1, A10, D6, H1,
H12. ) Run the FM Scan for each well (step 8
above) and record the Bottom Elevation for each
well. Average the values to obtain the
recommended Bottom Elevation for the plate.
Enter the average value into the Bottom
Elevation field.

Note: When using Laser Auto Focus (LAF) this process is not required.
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FM Scans

Good Bad

Good results: a well-defined peak. Save these settings for
your plate type.

Bad results: insufficient range; peak not found. To get
better results, expand the Scan Distance under
Advanced Options and rerun the FM Scan.

Defining Custom Labware

Gen5 offers tools for creating your own "plate type" or "labware." If your imaging assays are performed in
chamber slides or other non-standard microplates, you can define custom labware. For best results, use
calipers to measure the vessel's dimensions, and/or obtain specifications from the manufacturer.

Best practice: Begin with an existing plate type. When creating new plate types and labware, it is
easier to start with the dimensions of a predefined vessel similar to the new one.

Some rules apply:
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l Vessels must be the same size

l Wells must be the same size

l Each vessel must contain the same number of wells

To speed up the process, take a photo of the vessel to use as a template:

Create a labware record: Follow the prompts when loading a photo of the labware:

1. Select System> Plate Type.

2. Click .

3. Choose an existing plate type as a
guide, if possible.

4. If possible,
upload a photo of the vessel to use
as a guide.

5. Follow the on-screen prompts:
Click on each edge of the labware when prompted.
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Use a combination of "clicking and dragging" the drawing tool and filling in the dimension fields with
approximate values to define the new labware. Note: the imported picture is used for reference only and
is not retained.
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Experiment with the controls to determine which work
best for you. Often, hiding the picture makes it easier to
fine-tune the well sizing.

Gen5 marks your finished labware record as a "Favorite"
automatically, making it easy to select when defining a
session.
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4 - Experiment Mode Imaging

Automating Your Assay

Best choice: Manual Mode or Experiment Mode?
Choose the imaging mode that best fits your needs:

l Manual Mode, (2.1 - Acquiring an Image as shown on page 37), is a good starting point to
fine-tune focusing and determine the best parameters to apply in an experiment. Manual
mode is sufficient to capture a small number of images, low throughput, or for analysis with
either Gen5 or an external software program. Choose manual mode to make movies or
capture images for presentations. Gen5 file type: .IMM

l Oil Immersion and High NA Objectives are only supported in manual mode.

l The Upright imager Finder Scope is only available in manual mode.

l Experiment Mode is the best choice to capture multiple images and analyze them with Gen5
and for high-throughput multi-plate processing and analysis. Finding and imaging ROIs can
only be done in experiment mode. Gen5 file type: .XPT

l Some features are only available in experiment mode: Laser Autofocus, ROIs, Beacons, etc.

Manual Mode Image Capture Experiment Mode

4.1 - Creating an Imaging Experiment 99
4.2 - Difference Between an Experiment and a Protocol 103
4.3 - ROIs and Beacons 104
4.3.2 — Auto ROI Add-On Module 109
4.3.3— Add Beacons to Mark ROIs 118
4.3.4 — ROI Manager for Batch Processing 121
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4.1 - Creating an Imaging Experiment

Three ways to create an imaging experiment:

1. From a Manual Mode (.IMM) session (See 2.4 - Conversion to Experiment Mode on page 47).

2. Create a new experiment from scratch from the Task Manager: select Experiments>Create New
and opt for a Standard protocol.

3. Create a new experiment based on a protocol from the Task Manager. (Learn about Gen5’s
Differences between Protocols and Experiments page 103.)

l Click the Gen5 icon in the toolbar to open the Task Manager:
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Modifying an Experiment

After opening an experiment file, here are steps to enhance it:

1. Click Procedure.

2. Plate Type: Pick your pre-made plate definition from the Plate Type drop down list. Check “Use Lid”
if applicable. (Make sure your plate definition is optimized with your samples (as described on page
92).)
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3. To add a step, click
Image.

4. Tell Gen5 if you want to
find ROIs and, if
applicable, how.

See 4.3 - ROIs and
Beacons on page 104.

Note: You can
search for ROIs and
then image them
using any imager and
any magnification.

5. Select theMagnification
(Objective) to use.

6. Define a plate map or
keep the Full Plate, if
applicable.

7. Depending on the imager,
choose the light source,
e.g., Color LED cube and
filter cube for up to 4
channels.

8. Exposure: To use Auto
Exposure, check Auto and
click theWells

button.
Select both positive and negative wells (highest and lowest intensity) for the best auto exposure results.

l Plate map shortcut: Instead of choosing one well at
time, click a column or row header to choose that
entire block.

l

Alternatively, de-select Auto and click to
launch manual mode and choose optimal exposure
settings for each channel.

9. Now, you can process all your sample vessels/plates using the optimal settings. Click OK to close the
Read step.
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10. Click the Read button.

Note: If your samples are not in focus, you may need to check the focal options and optimize them
(See 5 - Understanding AutoFocus on page 124).

Upright Imager experiments: Fixed focal height is typically a good choice when using 2X
magnification. Image capture results are equivalent to Autofocus and fixed focus is significantly faster.
Click Focus Options to enable this feature.

Laser AutoFocus is recommended for most confocal experiments.
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4.2 - Difference Between an Experiment and a Protocol

Gen5 uses two common terms to define distinct elements of its toolkit.

Protocol (*.prt) Experiment (*.xpt)

A protocol is a set of instructions designed to
capture, transform, and report and/or export
data.

An experiment has a copy of the protocol and at
least one plate. It executes the instructions
provided by the protocol to produce results.

Protocols are created and saved as stand-alone
files. They function as a template; an unlimited
number of experiments can be based on one
protocol.

Although an experiment is created using an
existing protocol, that protocol can be modified
within the experiment.

A protocol consists of reading requirements, like
detection method and wavelength, and reading-
related actions, like shaking and incubation
(procedure), plate layout, data reduction, and
data viewing, reporting, and exporting
parameters.

Running an experiment is the only way to
process a protocol.

The Read Now button is available after a
read step has been defined in a protocol; Using it
creates an experiment based on the protocol.

A protocol can be used repeatedly (as is or
modified) within experiments. By itself, a
protocol does not produce results. Protocols do
not have plates associated with them.

Multiple plates can be processed in an
experiment, each one considered a unique assay
with independently reported or exported results.

.prt is the protocol’s file name extension. .xpt is the experiment’s file name extension.

Changes made to a stand-alone protocol are not
reflected in any previously created experiments
based on that protocol. A new experiment must
be created to apply the revised protocol.

Within an experiment, you can select Save
Protocol As to capture the current details of the
protocol and save them as either a new protocol
or as an overwrite of the original protocol.

Learn more in the Gen5 Help system.
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4.3 - ROIs and Beacons

Two distinct methods are available for identifying and imaging Regions of Interest (ROIs) in an
experiment:

1. ROI Identification Experiments: Discover ROIs using low magnification, image ROIs using high
magnification. (Gen5 v.3.09 or higher required.) See Identifying ROIs in Gen5 on the next page.

2. Add Beacons to Mark ROIs: Place a beacon on each ROI in every well individually when creating
the Gen5 experiment. (Gen5 v.3.08 or higher required.) See 4.3.3— Add Beacons to Mark ROIs on
page 118. With Gen5 v3.12 or higher, a pattern of beacons can be assigned to multiple wells
simultaneously: See Using a Grid to Define Beacons on page 120.

Gen5 also provides tools for automating ROI processing:

l ROI Batch Processing: Using a BioStack plate stacker to process multiple slides or microplates
containing ROIs. (Gen5 v.3.10 or higher required.) See 4.3.4 — ROI Manager for Batch Processing
on page 121.

l Auto ROI Add-On Module: After purchasing and activating the Auto ROI add-on module, Gen5 will
find ROIs automatically based on user-defined criteria. (Gen5 v.3.11 or higher required.) See 4.3.2
— Auto ROI Add-On Module on page 109.

Advantages of ROI imaging options

ROIs Beacons

Interactive discovery step to find ROIs gives
users ultimate control

Easy one-step ROI definition (after navigating to
each well or by applying a grid of beacons to
multiple wells simultaneously)

Presentation of the whole plate makes it easier to
identify wells with ROIs

All ROIs are the same size and shape

Custom sizes and shapes Both wells with and without ROIs are imaged

See Identifying ROIs in Gen5 on the next page See 4.3.3— Add Beacons to Mark ROIs on
page 118
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Watch this ROI Feature Training Video.

Identifying ROIs in Gen5

In Gen5 versions 3.09 and higher, Gen5’s Regions of Interest (ROIs) feature is a three step process:

1. Discovery step: scans a sample using low magnification to let you see the entire sample area.

2. ROI definition: the user draws a rectangle or polyline shape to define the ROIs in each well and/or
defines criteria for Auto ROI identification.

3. ROI captured: Gen5 images the defined ROIs using high magnification (typically). Only wells with
a defined ROI are imaged; blank wells are skipped.

l Follow these Step by Step ROI Imaging instructions.

l If the add-on module is installed, follow these Auto ROI Step by Step instructions to
automatically detect ROIs.

l

ROI Manager for Batch Processing: For slide scanning assays and other multi-plate
experiments. Especially useful when using a BioStack to capture ROIs.

Step by Step ROI Imaging

1. Create a new experiment with an imaging step and tell Gen5 to find ROIs.

2. Choose the imagers, if applicable, to perform the discovery and imaging steps.

3. First, in the discovery step, define the entire potential field for the ROIs.

Use theMontage entire well shortcut to cover the entire well, if useful.

Click Full Plate to limit the wells to be imaged, if applicable. This setting will be fixed
for ROI imaging, also, except that only wells with one or more defined ROIs are imaged.
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4. Retain the default settings in the ROI Setting dialog, at least initially. You may want to adjust the ROI
margin after gaining some experience with the process.

5. Define the image acquisition step with the desired magnification and color channels. Click Validate
to make sure the procedure can be performed as defined.

6. Read the plate.
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ROI Discovery Step

1. At the ROI Identification Matrix, click in a well to define its ROIs.
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2. Save Changes for each individual well.

3. When all ROIs have been defined, click Image ROIs.

See Viewing ROIs on page 122.

ROI - FAQs
l Gen5 only images wells/vessels that have a defined ROI; wells or slides that do not have an ROI are
skipped.

Important: Gen5 expects that ROIs will be captured in a montage. Thus, even when the ROI
requires only a single tile, you must manually add an image stitching step (under Data Reduction)
before you can create a Z-Projection (for example) or perform other processing steps.
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l The initial image step in the process, the ROI Discovery image (usually captured with low
magnification for the largest field-of-view) is saved with the experiment. It can be viewed, reported,
and exported.

l Gen5 applies its standard naming convention to ROIs: Well Name-ROI:ROI-index.

l Image statistics can be reported for an individual ROI and/or the sum/average of All ROIs in the
well. However, cellular analysis object detail data sets are not supported. When it’s available, “Each
ROI” is a nice timesaver for reporting all ROIs individually.

l Timestamps: As it does for montage and z-stack captures, Gen5 will retain one timestamp for all
images/ROIs in the well. This time will be used to perform kinetic analysis. Likewise with
temperature data points, Gen5 will keep one per well.

l Autofocus can be performed on each ROI or limited to the ROI closest to the center of the well.

l Kinetic time lapse imaging: a kinetic loop can be added
to the ROI procedure after the imaging step has been
defined.

l Image Statistics in an image zoom: the highlighted
data points are reported from image metadata not from
measuring the current ROI. The height and width are
based on the .tiff itself, not the ROI dimensions.

l Slide scanning assays using a BioStack are supported
with an ROI Manager.

4.3.2 — Auto ROI Add-On Module

Requires Gen5 v.3.11 and the AutoROI Add-On Module

To automatically identify and capture ROIs, the Auto ROI Add-On module must be purchased and its
license activated.

Auto ROI is especially useful for capture and analysis of core sample slides. In combination with a
BioStack, slide scanning applications are made fast, easy and reliable.

Good to Know:
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l Auto ROI and manual ROI tools: Gen5 lets you use both
manual and auto ROI tools in the Auto ROI identification
step. This option is recommended for best results.

l Important: always define and run the Auto ROI Selection
Criteria before using the manual ROI tools (rectangle or
polyline) to identify objects missed by the Auto ROI criteria.

See also ROI - FAQs on page 108.

Auto ROI Step by Step

Auto ROI Add-On module required.

Doing a preliminary manual mode session to evaluate your samples to measure object sizes and
distances may be helpful for customizing the Auto ROI parameters.

1. Set up the ROI experiment similar to the manual method: Step by Step ROI Imaging as shown on
page 105.

TheROIDiscoveryStepwasdefinedthisway,usingaCytation7,toaccommodateourcoresampleslide:
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2. In the ROI Settings, enable both Auto and manual ROI options:
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Using both auto and manual ROI identification options adds a useful review step to the automated
process. See Auto ROI Parameters on page 114.

Adjust the Auto ROI parameters as needed for your samples. (You will have a chance to optimize
the parameters later.)

3. After the discovery step, click on a well to fine-tune the ROI definitions in the ROI Identification
Matrix. The automatically generated ROIs will be visible. If the ROIs are not optimal, revise the
parameters.

You can use both the Selection Criteria measurement values and the manual ID tools.
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Note: You can delete both manual and auto-generated ROIs, too.

When you are happy with the selected ROIs: Save Changes and Image ROIs. Gen5 will capture
all the ROIs that match the criteria.

4. After the ROIs are captured, you can view each one, and perform analysis on all of them
simultaneously.
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See also Auto ROI - Fragmented Samples on the next page.

Auto ROI Parameters

Auto-Select Channel Channel used for running the Auto Thresholding for ROI
detection. This can be any of the channels defined in the
Discovery (low-mag) scan.

Threshold Same dynamic threshold algorithm used in Gen5 Cellular
Analysis.

Dark background Toggle for either Brightfield or Fluorescence images. Dark
background: Fluorescence Images (and sometimes Phase
& HCBF); Light Background: Transmitted Light, BF & CBF.

Minimum object size Smaller objects will be ignored.

Maximum object size Larger objects will be ignored.

Minimum fragment size Smallest object of interest.

Maximum fragment distance See Auto ROI - Fragmented Samples on the next page.
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Inflate mask size To include some background (or signal below the
threshold) around each ROI. Inflating the mask size is
recommended to accommodate growth of the ROIs
during kinetic analysis.

Use rolling ball - Rolling ball diameter Reduces the background, potentially eliminating
elements that may be erroneously considered ROIs.
Rolling ball size is typically less than or equal to the
minimum object size. Too small a rolling ball size will
erase valuable foreground signal.

Auto ROI - Fragmented Samples
Tissue samples often fragment when fixed to a slide. Gen5 provides Auto ROI parameters to let you
define the fragments as either individual ROIs or combined into one ROI.

Here is an example of an H&E liver section slide.

The liver section can be defined as 1, 2, or 3 ROIs
depending on the values assigned to:

l Minimum fragment size

l Maximum fragment distance

l Min and Max object sizes

Let’s consider the two largest segments as our min and
max object sizes. The small segment will be a fragment.
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The minimum fragment size will be 2000 µm, telling Gen5
to treat it as an object of interest.

Note: to define each segment as its own ROI, make the
maximum fragment distance less than the 900 µm,
shown below.

To create two ROIs, one combining the two largest
segments; and making the fragment the second ROI, we
would set the maximum fragment distance to 900 or
1000 µm.

(the fragment is further away)

To create one ROI that combines all three segments, we
would set the maximum fragment distance to exceed the
size of the gaps between the segments.
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Depending on your samples, you may want to Inflate
mask size to include some background (or signal below
the threshold) around each ROI.

Inflating the mask size is recommended to accommodate
growth of the ROIs during kinetic analysis.
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4.3.3— Add Beacons to Mark ROIs

Requires Gen5 version 3.12 or higher for all features described

By default Gen5 captures images at the center of the well. Two ways to change the X/Y position of the
capture area in an experiment are:

l Beacons: to identify regions of interest, when the ROIs vary from well to well. Beacons may be
useful in kinetic assays when cells have moved away from center, for example.

l Horizontal and vertical offsets: When the region of interest is not in the well center but occurs in the
same area (X/Y coordinates) of every well.

Beacons or offsets can be used in scratch assays when the scratch is off-center.

Defining Beacons - ROIs

Instead of capturing the center of a well,
you can capture one or more ROIs in the
vessel by marking the ROI with a beacon.
The beacon specifies a horizontal and
vertical (x/y) offset in the well.

Note: Also see: Using a Grid to Define Beacons on page 120.

1. In the imaging Read Step dialog, set the Objective and

Color and select Define beacons, then click to
define the beacons. Gen5 launches a special manual mode
session to let you define beacons. Use the focus and
exposure tools as needed.
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You can change the magnification (lower or higher power) and/or the
color when identifying beacons, if desired.

2. Click theWell button to select the well in which you want to define beacons.

3. Move to the ROI using the navigation tools. For example, using the well map, click inside the well
schematic to move to the corresponding location in the well, then, click the image itself to place
the beacon. + A red cross in the image itself and a red cross in the well map marks the spot of the
beacon.

Multiple ways to assign and manage beacons:

l Click inside the image itself to identify
the ROI/beacon.

l Click in the well map to move to that
area of the well. Gen5 updates the
coordinates to identify your location.

l Use the arrow buttons around the well
map to move in that direction.

4. Gen5 activates the multi-beacon controls
once beacons are defined. Use the top
control to evaluate and modify beacon
selection.

5. To define beacons in another well, repeat
steps 2 through 4.

6. When you are finished defining beacons
on that plate, click Save settings.
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In the read step, click the plate button to
see where beacons are defined. Hover the mouse over
the well to see its offsets.

Good to know:

l Image statistics can be reported for an individual ROI and/or the sum/average of All ROIs in the
well. However, object-level metrics are not supported for multiple beacons/ROIs. When it’s
available, the “Each ROI” option is a nice timesaver for reporting all ROIs individually.

l Gen5 applies its standard naming convention to ROIs: Well Name-ROI:ROI-index

l Max number of beacons is 255.

l When beacons are not assigned to a well, Gen5 captures an image for that well as normal, in the
center of the well.

l Kinetic image registration: the beacon closest to the center of the well will be used when this option
is enabled.

l Timestamps: As it does for montage and z-stack captures, Gen5 will retain one timestamp for all
images/ROIs in the well. This time will be used to perform kinetic analysis. Likewise with
temperature data points, Gen5 will keep one per well.

l Autofocus can be performed once per well on the center-most beacon or for every captured image in
a well.

Using a Grid to Define Beacons
Requires Gen5 version 3.12 or higher

When defining beacons, Gen5 lets you assign multiple beacons in a grid pattern. Using a grid in
combination with "Copy beacons to all wells in vessel" is a fast way to apply beacons to multiple wells.

Here are some details about using the grid:

l To apply a grid to a well, enter the number of Rows and Columns
and click Create grid. After the grid applies the beacons, they
behave normally. You can add, move, delete, and manage the
beacons as usual.

l To change the grid dimensions, first clear beacons from either the
current well or the entire plate, as needed.
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l Use the copy-to-all button to repeat the placement of beacons in a
well to all wells on the plate. Gen5 offers to erase all existing
beacons before copying the current pattern to all wells.

l Beacons are evenly spaced in the well when a grid is applied.
For circular wells: well width/height = diameter/√₂.
For rectangular wells: well width/height.

Gen5 does not remember the grid, it is simply a tool to quickly assign beacons.

Copy beacons to all wells in vessel
When defining beacons, Gen5 offers this copy-to button to speedily assign beacons to all wells in the plate.

If the "regions of interest" in each well are somewhat uniform in distribution, you can assign beacons in
one well and copy that distribution pattern to all other wells. You can start with a grid and then manually
move, delete, or add beacons in the well to be identify ROIs. Gen5 will copy that beacon configuration to
all wells when you click Copy beacons to all wells in vessel.

Note: Gen5 prompts you to delete any existing beacons before executing the copy function. Choose
the behavior that will work best for your vessel.

4.3.4 — ROI Manager for Batch Processing

Requires Gen5 version 3.10 or higher

Especially useful for slide scanning and similar assays using the BioStack plate stacker, the ROI
Manager saves the original discovery images and the captured ROIs with the experiment.

When using the BioStack, all plates in the original batch are imaged once in the discovery step. Then, the
ROI Manager presents each plate for ROI identification. When all ROIs have been identified, the ROIs are
captured in the image step, one plate after another.

Good to Know

l You can add new plates to the batch: When you process additional plates in an experiment, Gen5
adds them to the current batch, restarting the process just for those added plates.

l During the run, click Details in the status window to track progress.
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l Slides/wells and plates without defined ROIs are not imaged. Gen5 skips plates in the batch
that do not have ROIs identified after the discovery step. A message confirming this action is
displayed at the end of the run.

Viewing ROIs

ROIs are handled/treated like
other multi-image captures,
e.g., montage, kinetic.

Gen5 opens an ROI control
window after capture and
processing so you can view each
individual ROI.

Like other multi-index data sets,
individual images can be viewed
and analyzed, but certain
functions can only be performed
on “All” ROIs.

Gen5 expects an ROI captured with high magnification to be a montage, and thus always
presents the Image Stitching processing option. Montages must be stitched before Gen5
can analyze them.
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5 - Understanding AutoFocus

How to Choose the Correct Method for Your Assay

Gen5 offers two different types of autofocus: image (software)-based autofocus and laser-based
autofocus. Choosing the correct setting depends on the configuration of your system and the
biology in your wells. For ease of use, the default image-based settings can be used without change.

Choice of autofocus method has a significant impact on your assay, both on the reliability of
acquiring a focused image, but also on the total assay time. Image-based and user-trained
autofocus options come standard with all instruments. Laser Autofocus requires an additional
hardware accessory.

5.1 - Autofocus Methods 125
5.2 - Laser AutoFocus 132
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5.1 - Autofocus Methods

Gen5 offers 5 different algorithms for image-based autofocus, outlined below. For most imaging assays,
the default settings work well, except when certain circumstances require additional optimization. Gen5
applies default settings for an imaging read step based on the objective’s magnification.

Manual Mode Experiment Mode

In manual mode, expand

and select Advanced Options when
capturing a one-dimension image:

or click for multi-
dimension images, e.g., kinetic.

Autofocus Options

Note: Use default focus method and Use default focus method settings: Default settings
are based on the selected objective. If you change the objective, be sure to reset these checkboxes to
reapply the default settings for the current objective.

By default, Gen5 uses Channel 1 in your Read step as the focus channel and applies that focal plane to all
other channels; therefore, it is important to select your most robust signal for Channel 1. When possible,
a nuclear counterstain (DAPI, Hoechst, Draq5) works best or, alternately, the channel with the strongest
signal and the least well-to-well variability.
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Experiment Mode Only

When your assay involves signals in each
channel that do not have the same focal
plane as Channel 1, you can either apply a
predetermined offset to each well or
perform a separate autofocus step for each
channel.

Set this up by clicking Options under each
channel and using the controls at the top of
the dialog.

Image-based Autofocus Methods

AutoFocus Method Quick Description

1 AutoFocus with
optional scan

Gen5’s default method for fluorescence: Searches a small area,
broadening to a larger scan if optimal FM ratio is not achieved.

2 Scan then AF Scans a larger area then performs autofocus in the peak region. This is
the most time consuming but can be most accurate for complex or
unusual systems.

3 AF without Scan Fastest method when focus settings are already proven to produce
good images. This is a good option when wells are sparsely populated.

4 Brightfield AF Gen5’s default method for brightfield: Works like “Autofocus with
optional scan” but is optimized for the dual peak found in brightfield
and phase contrast images.

5 User-Trained AF Based upon a reference image, Gen5 is “trained” to recognize the
preferred focal plane in reference to the scan peak. This method takes
the longest. (Learn about User-Trained Autofocus in Gen5’s Help.)
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Autofocus Timeline

Watch this Image-Based Autofocus Training Video.

See also 5.2 - Laser AutoFocus on page 132.
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Image-Based Autofocus Explained

Image-based autofocus methods work by taking a series of images through a range of Z-planes to
determine the position with the highest “focus metric” or “FM.” Focus metric is a number used to evaluate
how well an optical system was focused when an image was taken (or how sharp are the individual
elements of an image).

During image-based autofocus, Gen5 moves the objective along the z-axis, beginning at the plate’s
bottom elevation, and takes three images. The FM ratio is calculated for each image. From this
information, Gen5 determines where the focus metric will reach maximum (best image), moves the
objective to that position and takes the next image. The process repeats until no significant FM
improvement can be achieved. A final image is taken at that position. This is referred to as a “Search” or
simply “Autofocus.”

Sometimes the initial estimate for the autofocus starting point may be wrong and the “Search” fails. In
this case, a wide focus metric scan can be performed to find a z-location where the focus metric reaches
its maximum. This process is called a "Scan."

Additional parameters can also be adjusted in your autofocus method, including Scan Distance and Scan
Increment, Auto Exposure Options, and Minimum FM Ratio. These parameters can be adjusted to
optimize speed or adapt to difficult biology. To optimize speed, and to practice adjusting these
parameters, try the exercise below in comparison with default settings.

Objectives move in the Z-axis towards optimal focus.
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Speed Up Focusing Process

When using low magnification with both upright and inverted imagers, e.g., 1.25X or
2.5X, with large depths of field, setting a “Fixed focal height” (at the top of the screen) is
the best way to speed up AF.

Save time by speeding up the focusing process in your experiments. First, open the "Read" step in your
experiment and click Focus options for the first channel, (DAPI in above image):

1. De-select both Use default focus method and settings.

2. Change Focus method to "Auto focus without optional scan."

3. Change the % of capture exposure for focus to 50.
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4. Under Auto-Exposure Options, reduce the Target exposure % to between 35-45. This will slightly
underexpose images but retain sufficient dynamic range.

5. De-select the Use default integration threshold, and set the Integration threshold (msec) to 50. This
saves acquisition time by first forcing increased camera Gain and LED intensity.

6. Apply these settings to other channels by setting them to: Focal height from first channel (+ offset)
at the top of the screen.
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5.2 - Laser AutoFocus

Agilent offers an optional laser-based autofocus accessory — a commonly-used alternative to image-
based autofocus. Especially in Bright Field, laser autofocus is typically more reliable, with better
repeatability, making it the recommended option when making movies. Unlike image-based autofocus
methods that need to take and compare multiple images, laser autofocus usually takes only one image
per well to determine optimal focus.

Advantages compared to the image-based autofocus methods include:

l Speed

l Lower phototoxicity

l Kinetic assay support with better reproducibility

l Repeatability

Also important to know:

l Laser autofocus is only available in experiment mode.

l Laser autofocus is supported with 4X-60X phase and standard objectives. Short-working-distance
objectives are not supported (i.e., oil immersion, some APO, etc.)

l Not recommended for moving biology: if cells are moving in the Z direction, this method could miss
your desired focal plane.

l Plate bottoms must be perfectly clean.

l Do not use plastic microplates with a 10X power objective. Variances in plate thickness cause
enough variances in reflected light to interrupt the autofocus process. Use glass plates for best
results especially when using a 10X objective.

l Laser AutoFocus is recommended for most confocal experiments.

Prerequisite: Install the Laser Autofocus Cube as shown on page 229.

Watch this Laser Autofocus Training Video.

How it works - Laser Autofocus

1 Capture Reference
Scan

The user finds the desired focus for their sample. Gen5 activates the
laser cube to scan the surrounding Z height and marks the position of
desired focus.

2 Gen5 Compares and
Aligns

During the plate read, the laser marks the spot and an image is taken.
Gen5 compares the image to the reference scan and moves the
objective up or down (z-axis) as needed to exactly match the focus of
the reference scan.

3 Repeat Focus process is repeated in each well of the plate.
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How to use Laser Autofocus

1. Create a new experiment with an imaging
read step.

2. Select the objective and color channel.

3.

4. Recommended: manually determine
optimal Exposure settings (as usual).

5. Click Focus options.

5. In the Autofocus window, de-select Use
default focus method.

6. Set Focus method to "Laser autofocus."

7. Follow the Gen5 prompt to capture a
reference scan now (or click the button to
perform this step later).

The button is framed in red before a scan is captured. To
recapture a scan, click the button again.

8. Select aWell with the best signal, and
focus on the sample as you would
normally.

9. When you are satisfied with the image
quality, click Save Settings to "Capture
the Reference Scan."

This defines the objective's optimal focus
position for reading the plate.

For best results, always capture or re-capture a
reference scan for each experiment to ensure precise
positioning, especially with high-power objectives.
From batch to batch, microplates can have different
bottom-thickness tolerances.

Proceed as normal with the Gen5 experiment, e.g. Read the plate. Gen5 will determine and apply
the offset of the objective to the sample for every well in the plate.
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Troubleshooting Laser Autofocus

Important:Donotuseplasticmicroplateswitha10Xpowerobjective. Useglassplatesforbestresults.

Gen5
provides
options for
fine-tuning
laser
autofocus
when the
default
settings do
not produce
satisfactory
images.

First, view the reference scan (example below) to help identify the problem. Depending on the
objective magnification, you should see one or two well-defined peaks in the middle of the scan sensor
range (x-axis); one peak of high pixel intensity, and a second peak of lower intensity.

l If any peak's pixel intensity is greater than 50,000, the sample may be overexposed. Re-capture
the scan and, as needed, Override laser exposure settings to manually adjust them.

l No peaks, may indicate under exposure, which in any case requires refocusing: re-capture a
reference scan. If problem persists, increase exposure settings.

l Some microplates do not reflect the laser light and cannot be used in this
application.
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Poor or inconsistent image capture results:

"Disable use focal plane from previous well" is provided to
prevent a bad well from distorting focus values for all subsequent
wells. Laser autofocus normally references the previous well for
its focal starting point. If, for example, contamination on the
plate bottom confuses the laser, this option limits the problem to
one well. It tells Gen5 to rely on the Bottom Elevation for its
starting point.

Out-of-Focus Images

For all autofocus methods, when all attempts to
capture images that match the current settings fail,
Gen5 takes the best or closest image possible. Thus,
Gen5's autofocus methods may acquire out-of-focus
images or images that do not meet criteria. When this
happens, Gen5 marks the well with a red border in the
plate view matrix.
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6 - Image Processing

Optimizing Your Image

Image processing refers to the mathematical modification of images to improve their quality.
Agilent gives you full control of your images and data, thus, the images presented immediately
after acquisition are truly raw. It’s your choice to apply any of several processing methods to
improve the image for aesthetics and/or analysis. Depending on the type of image acquisition,
these methods include:

l Image Preprocessing (Background Flattening and Smoothing)

l Deconvolution

l Digital Phase Contrast

l Image Stitching (covered in 3.3 - Image Montage as shown on page 64)

l Z-Projection (covered in 3.4 - Z-Stacking as shown on page 72)

l Kinetic Frame Alignment (covered in 3.5 - Kinetic Image Capture as shown on page 79)

After acquisition in Manual or Experiment Mode, the Brightness and Contrast (B&C) Control window
is immediately available. B&C modifications do not alter your raw data in any way. To add other
processing steps, select Process. Processing options relevant to your acquired images are
presented.

6.1 - Annotation Tools 141
6.2 - Image Preprocessing 142
6.3 - Digital Phase Contrast 143
6.4 - Deconvolution 146
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Manual Mode
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Experiment Mode

Or:

Add a Data Reduction step to the
experiment (or protocol):
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6.1 - Annotation Tools

Common software tools for adding notes to images are offered after you have captured an image. They
can also be used to annotate graphs and other elements of the Gen5 dataset.

Annotations Toolbar

Whenever the toolbar is present, you can add notes to draw attention to areas of interest in the image or
chart. Apply the grid to better identify objects. Show the size of objects with the "Measure" tool, etc.
These tools can enhance your reports and results analysis.

To use the annotation tools:
1. Click and drag across the

image.

2. Grab the element's nodes
to resize it.

3. Hover for a positioning
tool, to move it.

4. Double-click an item to
change its "Properties."

5. Right-click for a context-
sensitive menu.

Select Properties to change
the color and other elements
of the item.

From the context Annotation
menu, you can "Group"
multiple annotations to move
or copy them.

After using a tool to add an item to the image (like the ellipse shown above), right-click on the element
and select Properties to change its appearance.

Annotations are saved with the images that are saved for presentation; in movies made from kinetic
reads; and in reports and exports.
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6.2 - Image Preprocessing

Gen5’s image preprocessing step flattens the background and smooths objects' edges to create a cleaner,
sharper image. Background subtraction uses a rolling ball algorithm in which an area of defined size (the
“rolling ball”) moves through the image. Within the area, all pixel intensities are averaged, and this mean
value is subtracted from each pixel. Unlike Brightness and Contrast changes, Image Preprocessing alters
your data.

Use the Line Profile tool to estimate size and show comparative pixel intensities. It is useful for
determining the optimal rolling ball diameter.

Background:

With Image Preprocessing,
weak signal, such as
background, is eliminated,
creating a dark background.
However, with a poorly chosen
rolling ball size, legitimate
signal can also be removed.
Default settings are
approximately 3 times the size
of the most common objects.
Edit the Image Preprocessing
step, and de-select “Auto” to
customize the rolling ball size.
Smoothing: a method of removing noise at the perimeter of an object, can also be added in this step. In
smoothing, each pixel is replaced by an average of 9 pixels (a 3x3 pattern), a process that can be repeated
until perimeter lines more evenly follow the true shape of the object.
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6.3 - Digital Phase Contrast

Gen5 Image+ or Image Prime software required

Brightfield images may be improved by Digital Phase Contrast processing, especially when using 96-
or 384-well plates.

Digital phase contrast eliminates the "meniscus effect" that occurs in transmitted-light imaging (e.g.
Phase Contrast and Bright Field) in high-density plates. Digital phase contrast corrects the uneven
illumination and halo effect that is otherwise observed.

Gen5 performs three steps to apply digital phase contrast to acquired images:

1. Inverts the brightfield image (making it look like a phase contrast image).

2. Filters the image using a "Structuring Element Size."

3. Adjusts the image contrast.

When using 96- or 384-well plates, you may get better results by acquiring Bright Field images and
processing them with digital phase contrast than acquiring images in standard Phase Contrast mode.

How to apply Digital Phase Contrast:

l In Manual Mode, click Add step in the
Image Processing area (shown below).

l In Experiment Mode, define a Data
Reduction step (shown right).

Manual Mode

After adding a processing step, reselect the
image in the Image History and select Edit
step to alter the element size.

Experiment Mode
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Set the Structuring Element Size
Set the Structuring element size to match the size of the objects of interest in the image.

l Too large = geometric artifacts will distort the image.

l Too small = true signal in the sample will be lost.

Note: the bigger the element size the longer processing takes.

Digital Phase Contrast and Structuring Element Size Illustrated

Below is an illustrated explanation of how the 'Structuring Element' process improves Digital Phase
Contrast images. While we are showing the concept using 2D images, in the actual application, Gen5 uses
3D surfaces where image intensity is on the Z-axis. Gen5 scales the image to cover the full dynamic
range.

1. Original image:

dark objects on a light background.

2. Inverted image:

light objects on dark background

3. Structuring element (SE) slides below image
profile to establish background (horizontal lines in
this 2D image)
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4. Background found by previous step.

(Objects smaller than the SE were removed.)

5. With background subtracted, objects of interest
are light on a dark background.

In the final step, Gen5 scales the image to cover the
full intensity range from zero (total dark) to
maximum intensity.
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6.4 - Deconvolution

Deconvolution (Richardson-Lucy) removes a “blur” error caused by the optics system and is defined by a
Point Spread Function (PSF). Gen5 performs the deconvolution on a single image (2-D) using objective-
specific values. (Each Objective’s XML file stores its sigma value for the Gaussian Kernel standard
deviation.) Kernel will increase the overall area step being sharpened and Stdev distinguishes how much
sharpening over that area.

Before deconvolution After deconvolution

For most Gen5 users, the “Auto” option is the best choice. BioTek’s imagers are reliably stable over time,
so the factory-determined correction factor for each objective is a safe choice.

Alternatively, you can experiment with the correction values applied to the image to try to improve it.
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7 - Basic Image Analysis

Generating Quantitative Data from Your Images

Gen5 Image+ and Image Prime support these features

Basic image analysis helps you identify objects of interest, report desired metrics, and group them
into meaningful subpopulations.

7.1 - Primary Mask and Count 152
7.2 - Calculated Metrics 154
7.3 - Cellular Analysis Details 157
7.4 - Subpopulation Analysis 161
7.5 - Define an Image Plug 165

To get started, click Analyze inManual Mode:
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In an image zoom in Experiment Mode:

149

7 - Basic Image Analysis



Analyze Tool
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If the default settings do not identify objects sufficiently, or you want to add metrics, or create a more
detailed analysis, click Options (under the Start button). Additionally, if you wish to compare your
analysis across multiple wells, you can “Add Image Set,” at bottom of window to select additional wells
(for example, your positive and negative controls). “Options” opens the Cellular Analysis tools:

1. Primary Mask and Count provides the tools for setting the broadest definition of your object, for
example nuclei in mammalian cells. Start by changing the Threshold and object size if the default
settings do not correctly identify your objects.

2. Secondary Mask is only available if you have purchased Gen5 Image Prime and allows for more
detailed, high content analysis of your images.

3. Calculated Metrics allows you to select the readouts that will generate meaningful data for your
assay.

4. Subpopulation Analysis allows you to define sub-groups of your objects using AND/OR operators
and choose the data you want to generate for these groups.
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7.1 - Primary Mask and Count

In Cellular Analysis, images can be analyzed for cell level details, like object size, intensity, and
circularity. Gen5 reports a total count for all identified objects in the image, defining them with a Primary
Mask. The most critical parameter to identifying all of your objects is Threshold. A threshold sets the
minimum pixel intensity value for the signal of interest. The threshold defines which pixels to
include in an object mask. When a threshold of 10,000 is applied, for example, only objects with a pixel
intensity from 10,000 to the max 65,520 are identified and circled with a mask. If the threshold were
increased to 20,000, the size of the object mask will shrink or disappear since only pixels from 20,000-
65,520 are included. The images below illustrate the masking behavior at two thresholds:

You can clearly see that when the threshold is increased, fewer objects are included in the count.

Any fluorescently-labeled image can be the detection channel and used to set the threshold of the
detection mask for measurement purposes. The mask set in one detection channel is cloned to all
downstream channels so that intensity measurements can be made. Typically, a nuclear DNA-binding dye
such as Hoechst or DAPI is the primary detection channel for a nuclear mask (like the above
examples). However, in some applications a mask based on cytoplasmic or whole-cell stains is required. 

To Determine a Threshold:

Use the Line Profile tool to trace several representative regions of the image to determine a starting
threshold value. The Line Profile tool suggests a “25% = value” as a starting threshold value. When
multiple images or image sets are analyzed (in both manual and experiment modes), the same threshold
value is applied to all analyzed images so that data can be compared across images. Use the Line Tool
across several of the images that represent the dynamic range of the samples or assay, such as positive
and negative controls. Since the same threshold will be applied to all images, optimizing the threshold
based on the maximum intensity of the images typically offers the best analytical results.   
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Best Practice Tips:

l The Split Touching Objects feature is recommended in applications where object number is
important, such as proliferation, cytotoxicity, or migration studies to separate two or more
objects whose masks are touching. The Split Touching Objects feature may not be useful or
recommended in applications where the mask is set by cytoplasmic dyes or by multi-cellular
structures.

l Using Include edge objects in cellular analysis is application dependant. For applications
involving object counting, the user must decide whether to include or exclude edge objects;
Gen5 applies the rule across all image sets. When Area measurements are important, excluding
edge objects is recommended as the cells on the edge of the image are not complete and may
corrupt the analytical results.
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7.2 - Calculated Metrics

Gen5 can generate a wide breadth of quantitative data from your images. Select the Calculated Metrics
tab to choose which metrics are relevant to you. Click “Select or create object level metrics of interest” for
additional choices, particularly if you are a Gen5 Image Prime user.
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New users often find it challenging to
apply the available measurements in
Cellular Analysis to actual
applications. Here is an example
application to illustrate how
measurements of nuclear
morphology can be used to
determine a cell’s stage in the Cell
Cycle using a mask defined by a
DNA-binding dye such as Hoechst or
DAPI. For a cell in G0/1 phase, the nuclear
dye reflects 2N DNA content and will have
normal intensity and normal size and
shape.  Once a cell reaches G2, it has
replicated its DNA; at 4N DNA content
there will be a measurable doubling of
nuclear fluorescent intensity. This can be
seen at the cellular level using the Mean,
Peak, and Integral nuclear Intensities. 
When a cell reaches the M phase, it will likely have the same intensity as a cell in G2 phase as no
additional DNA replication has occurred; however it will have skewed aspect ratios due to spindle
formation in advance of cell mitosis. If only one measurement were made per cell it would be impossible
to determine the stage of the cell cycle, but in combination these measurements allow for advanced
morphological detection of the cell-cycle stages. 

Image Statistics
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In the Analyze pane, select Image Statistics and click Start to generate the following data:

Image Statistics

Mean (per color channel) Mean intensity of pixels in the object.

Min Minimum intensity value of pixels in the object.

Max Maximum intensity value of pixels in the object.

STD DEV Calculated using the standard deviation (n-1) of the intensity of all
pixels located inside or at the perimeter of an object.

CV Calculates standard deviation /Mean.

Saturated Pixels % Calculated by counting the number of pixels that have a value greater
than or equal to the saturation limit defined for the instrument’s
camera divided by the number of pixels in the image. Refer to
instruments specifications for saturation level and image resolution.

Focal Height Position of the objective in the Z axis (reported in microns).

FM Ratio FM Ratio is a ratio reported by the Autofocus algorithm.

Total Intensity Sum of pixel intensities above or below the threshold.

Total Area Sum of area of pixels above or below the threshold (reported in
microns).

Confluence Number of pixels above or below the threshold divided by the total
pixels in the image * 100.

Width Image width is extracted from the image metadata; dimensions in
µm.

Height Image height is extracted from the image metadata; dimensions in
µm.
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7.3 - Cellular Analysis Details

Creating Object Masks for Cellular Analysis

Process for identifying cells or "Primary Mask and Count."

1 Gen5 displays the acquired image as a
2D picture.

Each pixel on the screen corresponds
to a pixel captured by the camera.

The intensity of each pixel is
proportional to the signal level
received by the camera.

The pixel intensity is reported as a
number proportional to the level of
light falling onto the pixel: 0 for totally
dark to 65,520 for max intensity.

2 The goal of the cell identification
process (mask creation) is to
determine which objects in the image
to consider as valid cells or objects-of-
interest, and what shape to assign to
each object.

(The process is done mathematically,
but these illustrations provide a way
to visualize the steps of the process.)

The 2D image is transformed into 3D
space with X-Y plane representing
pixel location and Z axis representing
pixel intensity. In this 3D space, an
object's height is proportional to its
pixel intensity in the image. Bright
objects are tall and dim objects are
short.
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3 Gen5 provides a line tool to
measure the intensity profile of an
image. The user draws a line in the 2D
image, and Gen5 generates a vertical
plane of this line. The picture of this
vertical plane and how it sliced the 3D
objects is displayed next to the 2D
image.

The user can decide which objects are
too low in height (intensity) to count
as cells and at what intensity level to
start counting the objects as valid.
This intensity level is called
Threshold for cell identification.

25%: When using the line tool, Gen5 displays the 25% threshold
value, which is often the optimal setting.

4 In 3D space, a horizontal plane is
mathematically generated at the
intensity level equal to the Threshold.

This Threshold plane will slice through
3D objects whose intensity exceeds
the Threshold. Dim objects of low
intensity will stay below this plane.

5 If we now look at the Threshold plane
in 2D, it will contain contours where
the plane sliced 3D objects whose
intensity exceeded the Threshold.
These objects met the intensity
criteria for a valid cell.
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6 Next, the X-Y size of each object can
be compared to the minimum and
maximum object size specified by the
user. Objects that do not fit the MIN,
MAX criteria are ignored. Objects that
fall on the edges of the image (not
totally contained in the X-Y area of the
image) can be either included or
excluded from analysis.

7 Gen5 applies masks around the valid
objects that correspond to the user-
set criteria. Only the valid objects are
considered the "population" of
interest.

Each mask outlines an area of the
image to form individual objects on
the image (cells). Cell analysis is run
on these objects (e.g., count them,
evaluate area, measure perimeter,
etc.).

Note: The intensity of each object (cell) is not affected by the cell identification process.

Subpopulation Analysis

Gen5 provides further cellular analysis capabilities by defining and evaluating subpopulations.
Subpopulation analysis answers the question: which objects from a total population fit certain criteria.

The total population of cells was established as
described above using a Threshold and size filters. This
process was done using Color Channel 1 (DAPI in our
example).

The "population," i.e., total number of objects, is 3
defined by yellow masks.
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Intensity measurements in Color channels 2-4 can also
be used for analysis. Gen5 reports intensities in these
channels only on the objects defined by masks
developed in channel 1. We can call these
measurements “Red on Blue” (Red for intensity of Red
channel and Blue for the primary channel used to
identify the population or object masks).

In this example, if we define a subpopulation as objects with a certain Red intensity value, the total
number of objects would be 2. (The third cell is dimmer than specified.)
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7.4 - Subpopulation Analysis

Adding subpopulations allows you to identify sub-groups within a primary population. To continue our
cell cycle example, three useful subpopulations might be cells in G0/G1, S, and G2/M. Gen5 lets you use
as many of your chosen metrics as desired to make the definition as specific as possible. You can delimit
them further by choosing whether “All Conditions” or “At Least One Condition” must be met in order for
an object to be counted. Finally, you can select the desired metrics for each subpopulation and stack
them to create a custom subpopulations. See also Define a Subpopulation using a Graph on
page 164.
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Subpopulation Analysis: Result Options

Gen5 Image+ or Image Prime software required

Object Details: In the Analyze Tool, after applying the primary mask, determine useful
conditions for analysis using the Object details panel. It works both ways: you
can highlight a cell in the image or a row in the table to pinpoint results.

l click on a cell in the image,
or,

l click on a row in the table.

l click a column header in the
table to change its sort order
to that value.

l select multiple rows in the
table to highlight those cells
in the image (press Ctrl to
choose nonadjacent rows).
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In Cellular Analysis mode, click Options (under the Start button),
and select the Subpopulation Analysis tab. Choose a previously
defined population to edit or click Add to create a new one.

1. In the Object metrics field, highlight the element to evaluate and click Add Condition.

2. In the Edit Condition window, use the drop-down to select the function and enter a value or limit;
enter whole numbers only with no commas. Click OK.

3. In Cellular Analysis mode, click the Start button to rerun analysis and report the results of the
condition.

Important: Keep in mind the difference between using Parameters to apply the nuclear mask to
the image (e.g., Threshold) and analyzing subpopulations based on certain conditions found in the
analysis results. For example, you can use the Line Profile tool or a Scatter plot to determine an
optimal intensity threshold (to ignore objects that are not of interest).

Stacked Subpopulation Criteria: When multiple conditions can be used to generate useful
results, for example, objects of interest must be a certain size and/or within a certain shape, you can
Add Conditions for each criterion.

All or One: then you can require objects to meet all or just one condition.

See also Define a Subpopulation using a Graph on the facing page.
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Define a Subpopulation using a Graph

Scatter plots and histogram graphs provide a way to visually
define a subpopulation.
1. In Manual Mode, and after image acquisition and

processing, proceed to the Analyze Tool and select
Cellular Analysis, then click Start.

2. As needed, click Options to fine-tune the settings,
add a Secondary Mask, etc.

3. Click Create a Plot and choose Histogram or Scatter
X, Y plot.

4. Define the Data to plot on the X and Y axis and select
OK.

5. In the histogram or scatter plot, click and drag to
create a box around the points or bars that will define
your subpopulation.

6. Select New population in the context menu that
opens.

7. Assign a unique Name for the new population.

8. As needed, choose the All/Or conditions criteria. And,
highlight a condition and click Edit to modify its value.

9. Click OK to create the subpopulation.
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7.5 - Define an Image Plug

For some assays, limiting the analysis region in the image improves the statistical and cellular analysis
results. Applying a plug lets you exclude unimportant information. To apply a plug:
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Use the tools to define the plug:

1. First choose the Plug shape.

2. Then, draw the area of the plug on
the image.

3. Click and drag the plug to resize or
move it or use the numeric X and Y
values to position and size it.

4. If applicable, you can Invert the
mask.

5. Or, especially when defining an
experiment, Load a Test Image.

Note:

l the same plug is applied to all
wells in an experiment;

l the plug can be toggled on and off
in manual mode;

l using a plug may replace the need
to define complex subpopulation
filters.
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8 - Advanced Analysis

High-Content Analysis with Image Prime

BioTek’s Gen5 Image Prime contains specially licensed high-content analysis capabilities, as
highlighted in the table below. This section is relevant only to customers who have purchased
Image Prime.

Gen5 Image Prime takes image analysis to advanced levels including powerful analysis tools like
nuclear mask expansion and reduction; secondary mask for cytoplasm or whole cell identification;
custom object-level measurements for translocation and subpopulation analysis. Additionally, a
Spot Counting module is available for purchase, i.e., the Spot Counting module requires a unique
user license.

8.1 - High Content Analysis with Image Prime 171
8.2 - Secondary Mask 176
8.3 - Create a Scatter Plot or Histogram 181
8.4 - Spot Counting 185
8.5 - Create a Custom Object Metric 190
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Gen5 3.12 Editions Feature Comparison

Imaging Features/Analysis Gen5 Gen5
Secure/IVD

Gen5
Image+

Gen5
ImagePrime

1.25X to 60X support1 X X X X

Phase contrast2 (4X to 40X) X X X X

Montage X X X X

Z-stacking X X X X

Z-projection X X

Digital phase contrast X X

Image stitching X X

Cell counting (via primary mask) X X X X

Subpopulation Analysis X X

ROI Discovery experiments X X

Hit-picking X X

Imaging and other steps defined for different
sections of plate in one procedure

X X

Image binning to improve focus and acquisition
speed

X X X X

Custom labware support X X X X

Movie maker: live mode recording; kinetic
acquisition w/frame alignment

X X

Burst-rate acquisition: up to 10 fps at full
resolution, 20 fps with binning

X X

Cellular analysis and statistics in user-defined
plug

X X

Annotations supported in images, graphs, movies X X

Advanced Analysis Features:

Secondary mask to measure cytoplasm/whole
cell

X

Custom object-level metrics X

1Lionheart FX also supports 60X and 100X oil objectives
2except Cytation 1, Cytation 3, Cytation 7
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Imaging Features/Analysis Gen5 Gen5
Secure/IVD

Gen5
Image+

Gen5
ImagePrime

Object-level metric graphs: scatter plots and
histograms

X

Dynamic thresholding for cellular masks X

Subpopulation analysis using custom metrics X

Spot Counting add-on module X

Auto ROI add-on module X X

# Installations per serial number 5 25 2 2
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8.1 - High Content Analysis with Image Prime

Cellular Analysis Tools

1. In the Analyze Tool, select Cellular Analysis and choose the Detection Channel, if necessary.

2. Then, click Options to customize parameters to best identify or segment the objects of interest in
your sample.

3. Threshold: Typically, the default "Auto" or dynamic thresholding is most effective at distinguishing
items of interest based on their pixel intensity. But, a fixed threshold works better when intensity
varies greatly across the image or cell toxicity is a common occurrence in the images.

4. Segment objects of interest based on their size by setting the minimum and maximum object size to
best match your analysis goals.

5. Click Start to generate results.
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After reviewing the results, and using the analysis controls, like the Line Profile to determine the
optimal threshold and object size values, you can change the parameters and rerun the analysis: click
Start again to apply a nuclear mask to the image.

l Use the Advanced detection options to further identify objects of interest image based on the
object size.

l You can use the quick export buttons to save an image and/or its analysis results to Excel.

Experiment Mode: Define Data Reduction steps to perform this analysis in an experiment. Gen5 will
report the analysis for all the wells in your sample vessel.
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Image Processing and Analysis Optimization Control

Access via button at bottom of Data Reduction dialog

As some imaging experiments can take hours to complete, Gen5 provides these controls to let
investigators assess their image processing and analysis settings on a subset of the samples rather than
waiting for all the samples to be completed.

High throughput experiments, when using a BioStack, BioSpa or another robot, can also benefit from
use of these controls to free up resources for image acquisition. When all images are captured, the
control can be released to let Gen5 process and analyze them.
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When the controls are set the button label changes to indicate it.

Recommended work flow:

l HTS - for high throughput screening: set to None to delay processing and analysis until all images
are captured. Remember to reset to All when acquisition is completed.

l Kinetic and other complex experiments:

1. Select Custom and choose Wells to evaluate.

2. For Kinetic runs, select Range and set the number of reads to perform.

3. Read the plate.

4. Do a well zoom on a processed well to evaluate the affect of current settings.

Settings Need Editing Settings Are Correct

If processed images do not meet your
expectations, use an iterative process to revise
the Image Processing and/or Analysis steps,
reevaluate and repeat. When the parameters are
optimal, release the control: set to All.

If the images are satisfactory, release the control
(set to All) to apply processing and analysis to all
samples and reads.
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Note: When a Kinetic Frame Alignment step has been defined, the kinetic range cannot be limited.
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8.2 - Secondary Mask

Gen5 Image Prime required

Based on the primary mask, which is typically used to identify the cell nucleus, Gen5 Image Prime lets you
define a secondary mask to measure cytoplasm or the whole cell. Some examples of when a secondary
mask is useful include:

l Translocation assays: measure signal change between nucleus and cytoplasm

l Cell morphology: measure shape change in cytoplasm or whole cell

l Phenotypic assays: screening strategy for drug discovery

The secondary mask generates distinct data sets, which can be used in concert with those generated by
the primary mask: doubling your toolset for complex analysis with subpopulation filters and custom
object metrics.

Create a Secondary Mask

After defining the primary mask, Gen5 gives you several options for defining the area of the second mask:

l First, choose to
include or exclude
the primary mask
measurements in
your data set, i.e.
de-select the
checkbox to
exclude the
primary mask
from analysis.

l If included, you can Expand or Reduce the size of the mask, if useful.
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Examples:
l De-select the Primary mask measure to exclude the DAPI signal and measure GFP only in whole-cell
measurements. When measuring changes in cell size, apply a propagate mask threshold.

l Consider Expanding the mask to cover the perinuclear region if signal is observed there.

l Conversely, for translocation assays, you may want to Reduce the primary mask to prevent double
counting the intensity signal in the transition zone around the nucleus.

For whole-cell
measurements,
choose to Expand or
Reduce the size of the
primary mask by the
specified microns.

Use the line tool to determine the optimal size.

For cytoplasm
measurements,
specify the size of the
secondary mask based
on:

l Distance from the
Primary mask

l Ring width

Measurement areas are
defined by setting the
optimal distance from
the nucleus or primary
mask and the size of
the ring around the
nucleus.

Analysis can be
restricted to defined
ring, or include the
whole cell, with or
without the signal in the
primary mask.

Secondary Mask Threshold Methods
When measuring cytoplasmic intensity is required, applying a threshold improves the results. Two
threshold methods are available: Propagate Mask and Threshold in Mask. Both methods use the primary
mask as a starting point for the secondary mask, but grow differently.
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Propagate Mask Method Threshold in Mask Method

When the signal is high around the primary
mask. Applies threshold as it grows.

When objects are well separated or globally
circular. Applies threshold after it grows.

To measure variation in shape. To measure variation in intensity.

View the Masks On-Screen

After defining a secondary mask, choose
the “Channel” and fill theMask
checkboxes to view them (in the bottom
right corner of the window).

Gen5 Data Set Names
Naming the resulting data sets:

l Measurements in Channels 2-4 for Primary Mask show measurement and channel. Example:

l Object Mean (GFP)

l Object Mean (Texas Red)

l Measurements in Channels 2-4 for Secondary Mask show measurement_2 and channel. Examples:

l Object Mean_2 (GFP)

l Object Mean_2 (Texas Red)

Note: Data sets produced by Image Preprocessing, e.g. flattened background, have a Tsf prefix
(short for transformation).
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Secondary Mask Options

How to apply a secondary mask depends on the measurement goals; here are some examples:

Whole cell mask with threshold

Application: whole cell signaling; measuring cell area; confluence;
cytoskeletal changes.

Cytoplasm and nuclear masks with threshold

Application: cell shape changes like hypertrophy, cytoskeletal
changes.
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Excluding the perinuclear area, measuring cytoplasm and
nucleus (without threshold)

Application: translocation. No threshold is applied because when
the signal moves (translocates) the mask would disappear.

Excluding the perinuclear area, measuring cytoplasm and
nucleus (with threshold)

Application: HCS

Experiment with various settings and values, evaluating the differences by viewing the effects to
determine the optimal parameters for your assay.
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8.3 - Create a Scatter Plot or Histogram

Gen5 Image Prime required

A scatter plot or histogram can quickly inform you about trends in your assays. These graphs can be very
useful for:

l assessing the quality of the assay (e.g. too many outliers?) and how to optimize it;

l identifying cutoff values to use to filter subpopulations;

l identifying maximum and minimum values, etc.
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Multiple ways to create a scatter plot or histogram:

Manual Mode

After an initial round of Cellular Analysis, in the “Object details” pane click

See also Cellular Analysis: Manage Object-Level Metrics on page 195.

Experiment Mode

Two methods:

1. Drill into a well in the plate matrix(well zoom), click , create or edit an Image Analysis
step, in the “Object details” pane click (similar to Manual Mode).

2. In a Cellular Analysis Data Reduction step, select Calculated Metrics:
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Experiment Mode

1. Select Histogram or Scatter Plot. A dialog opens, in which you can define various settings for the
graph.

2. Define the x-axis settings:
a. Select data to display from the list. Any object-level metric displayed in the object details

pane is available.

b. Define the granularity of the histogram by setting the range. The range must be greater than
zero.

3. For histograms, the y-axis displays the cell count percentage for the selected metric; you can
choose the data sets for a scatter plot.
a. Using an Auto range means Gen5 sets the y-axis values from 0 to 100% of the population. If

your distribution is large, you can decrease the range so that the highest value is closer to the
highest end of the range.

When viewing a previously defined scatter plot or histogram, click Edit Graph to alter its
appearance.
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Scatter Plots and Histograms (Y-axis) can be scaled to
Log (or Linear). Data is not transformed, only displayed
according to selection.
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8.4 - Spot Counting

Gen5 Image Prime “Spot Counting” add-on module required

For assays that require measurements of intracellular small objects (“spots”) like steatosis,
autophagosomes, liposomes, micronuclei, viral infection, etc. Review the list of available
measurements: Spot Counting Calculations on page 189.

Best Practice: After applying a Primary or Secondary mask, view a representative well and use the

Line Tool to determine likely spot size.

1. Fill the Count Spots checkbox.

2. Set the Minimum and Maximum size values to ignore spots outside of the expected range.

3. Click Advanced options to refine the image for spot counting:
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Optimal settings for the rolling-ball size and threshold depend on the sample under study, but you can
experiment with different values, evaluate the effect, and fine-tune them until the best results are
achieved.

Note: Spot Counting is available only when you have defined either a Primary or Secondary mask.

Spot Counting Tips

Prerequisite: The Spot Counting module must have been purchased and its special license registered
with BioTek.

Enable spot counting and define its parameters on the Secondary Mask tab of Cellular Analysis as
described earlier. The following suggestions may improve your results.

While your sample may dictate different settings, often a good starting point for spot counting is
aggressive preprocessing to remove as much background as possible, making the spots easier to
detect. (You can edit an Image Preprocessing step that has already been defined.)
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1. Open Image Preprocessing.

2. Select the secondary channel tab (GFP in this example) and de-select “use same options as channel
1.”

3. De-select Auto and set the Rolling ball diameter to 1 µm.

4. Change Priority to Fine Results.

Primary Channel: Keep default or apply preprocessing settings for the primary channel as you
normally do for identifying nuclei, counting cells, etc. Aggressive background flattening only needs to
be done on the spot counting channel.
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l After performing the calculations, evaluate them in the Object Results table. Modify the analysis
settings, experimenting with different values to determine which give you the best results.

l To view the spots, use the controls in the Highlight objects panel (under the Object Results table).
View one channel at a time to enable all of the controls.
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Spot Counting Calculations

Gen5 supports the following object-level metrics. The highlighted items are selected and calculated by
default. On the Calculated Metrics tab, you can choose additional metrics to calculate and report:

Dimension measurements:
l Size

l Area

l Perimeter

l Circularity

Gen5 calculates these metrics using the same
formulas as Image Analysis - Data Reduction
Definitions.

Primary mask intensity measurements: Secondary mask intensity measurements:
l Area[<Channel>]

l Mean[<Channel>]

l StdDev[<Channel>]

l Peak[Channel]

l Integral[Channel]

l Spots Count[Channel]

l Spots Size[Channel]

l Spots Area[Channel]

l Spots Sum Area[Channel]

l Spots Mean[Channel]

l Spots StdDev[Channel]

l Spots Int[Channel]

l Spots Sum Int[Channel]

l Area_2[<Channel>]

l Mean_2[<Channel>]

l StdDev_2[<Channel>]

l Peak_2[Channel]

l Integral_2[Channel]

l Spots Count_2[Channel]

l Spots Size_2 [Channel]

l Spots Area_2 [Channel]

l Spots Sum Area_2 [Channel]

l Spots Mean_2 [Channel]

l Spots StdDev_2 [Channel]

l Spots Int_2 [Channel]

l Spots Sum Int_2 [Channel]
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8.5 - Create a Custom Object Metric

Gen5 Image Prime required

Gen5 lets you create your own “custom object metric” to measure cellular activity that is not currently
calculated in the default results. Similar to other Gen5 data reduction operations, you choose the data
sets and apply a formula to calculate the desired results.

Open the Cellular Analysis options in either manual or experiment mode:

Manual mode Experiment mode

1. After acquiring an image, add a Cellular
Analysis step.

2. Click Options.

Data Reduction>Cellular Analysis
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Manual mode Experiment mode

1. Select the Calculated Metrics tab.

2. Click the “Select or create object-level metrics of interest” link

3. Click .

4. Select up to five variables to use in your custom measurement:

5. Write a formula using the tokens, e.g. M1, that represent each variable and pick a Well Operator.

6. Give the new custom object metric a unique name.

You can include the custom metric in reports and use it to define subpopulations and other data
reduction steps.

See Custom Object Metric: Example Application on the facing page.
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Custom Object Metric: Example Application

Gen5 Image Prime required

Measuring nuclear translocation is commonly used to determine cellular response to a compound of
interest. In this example, we’ll create a custom object metric and apply it in a Subpopulation Analysis. Our
custom object metric will be a measure of the ratio between cytoplasm and nuclear signal. A single value
shows how signal is moving in both compartments.

Mean Translocation Ratio

Nucleus/Cytoplasm ratio: LOW Nucleus/Cytoplasm ratio: ~1 Nucleus/Cytoplasm ratio: HIGH

Resting State Cell Response

No Translocation Undergoing Translocation Full Translocation

Resting state: Before translocation cytoplasm is
clearly visible

Translocation: after translocation, cytoplasm has moved
into nucleus

After an “Image Preprocessing” step (called ‘Transformed GFP#’ in this example) to reduce the
background and improve the images for analysis, we will use the Cellular Analysis tools to create a
custom metric: Mean Translocation ratio.
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1
Apply a Primary Mask
to measure the
nucleus.

2
Apply a Secondary
Mask to measure
cytoplasm.

3
Follow the step-by-step instructions to open
Gen5’s controls: See 8.5 - Create a Custom
Object Metric on page 190.

Choose the primary & secondary data sets :

l Mean[Transformed[GFP#]]

l Mean_2[Transformed[GFP#]]

for the metric named “Mean Translocation
ratio”
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4 See Subpopulation Analysis: Result Options
on page 162.

Create a subpopulation definition: Mean
translocation cells

Define the criteria to fit your assay.

5 View results in the plate matrix:

6 Create additional data reduction steps:
Finally, to create useful
reports, charts, and
calculations, the “custom
object metrics” can be used in
additional data reduction
steps. In this example, we
created a Transformation to
use in Z-Prime and curve
generation.
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Cellular Analysis: Manage Object-Level Metrics

In the Data Reduction window, create a Cellular Analysis step>Select the “Calculated Metrics” tab>Click
link at bottom of window.

In the Manage Object-Level Metrics dialog, you can add or remove metrics from your view to refine the
results you want to see, and most importantly, to save the data with the experiment. Any object-level
metric can be used to generate a well-level metric.

Create/Edit a Scatter plot or Histogram

ClickManage graphs to add a scatter plot or histogram to the experiment data.

In Gen5 Image Prime, the metrics in the “Object metrics of interest” pane are also available in an
experiment created from a manual mode capture and can be used to plot a chart or create a table in the
online view or report/export file.

See also 8.5 - Create a Custom Object Metric on page 190.
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9 - Saving Files

Protect Your Data

9.1 - Saving Images 197
9.1.1 - Recommendations for Saving Your Images 198
9.1.2 - Strategies for Data Management 201
9.1.3 - Back End Data Management Tools 203

Gen5 Saving Options

Gen5 offers several ways to save images and other file types.
Files can be stored locally or on a server/network. A zipping
feature compiles the entire content of an experiment file or a
manual mode session, including any images, movies, data and
analysis into one single file. Zip files are especially useful for
sharing and moving experimental files and data.
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9.1 - Saving Images

Note: Agilent BioTek imagers can create big data sets. Live cell kinetic imaging and large scanning
assays are likely to generate data sizes that require management strategies. See 9.1.2 - Strategies
for Data Management on page 201 for options to consider employing to reduce image file sizes.

When a Gen5 session is saved, all acquired images are automatically saved in Gen5's Image Library.
Raw images are automatically saved as 16-bit TIFFs in native grayscale. TIFF is commonly considered
the best file type for saving the highest quality image for use in image analysis software and for re-
analysis with Gen5. To save colorized overlays with the scale bar or to re-save your raw data in an
alternative format, you can click as indicated below or simply right click the image.

In addition, acquired images can be saved in various file formats by manually invoking the Save
function.

In Analyze mode, bottom left corner:

l Save Image Raw Data saves the image in 16 bit TIF
format.  Multi-channel images can be saved as separate
files per image or as stacked images in a single TIF file.

l Save Picture for Presentation saves the image or current
display in color, rather than grayscale.  The scale bar and
zoom position in the image can be included. Several
image file options are available, including: TIF, JPEG,
PNG, GIF, BMP, and EMF.
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9.1.1 - Recommendations for Saving Your Images

In addition to 9.1.3 - Back End Data Management Tools on page 203, here are some suggestions to
consider for protecting your data.

Important: Consult with your IT (information technology) department to design and implement a file
storage strategy. Issues to consider include storage location, file-naming conventions, backup
frequency, and user access.

Agilent Recommendations:

l Keep All Files Local: If it is compatible with your work flow and work rules, store all your
experiment and image files locally on your computer's hard drive using either the Windows file
system or Gen5 database. Make sure the hard drive has the capacity to store all the images,
including a 20 GB virtual memory reserve. Consider attaching an auxiliary storage device to your
computer to expand its capacity. With your IT department, develop a plan to backup (or archive)
and/or share the files by transferring them to a network or external drive (see guidelines below).

l On a Secure Network Drive: If you have a reliable system network and multiple users need to
access the Gen5 experiment files and images, put them on a shared drive. Use Gen5's database
(SharedDB), which is required for compliance with the FDA's 21 CFR Part 11 regulation, to store
your experiment and protocol files. And create the Gen5 Image Library on the same network drive
as the shared database. (Select System>Preferences>File Storage to specify storage method.)

Important: If your network is not trouble-free, i.e. the network crashes or errors occur with some
regularity, then "Keep All Files Local" on a robust PC. This is the best way to avoid data losses.

l Turn off some automated features: In both cases, network or local, turn off the computer's
auto-update routines, virus scans, or other power settings that can interrupt a Gen5 experiment.
This is especially important when running kinetic or time-elapse assays.

l Follow instructions shipped with the imager re: Gen5's Computer Requirements to "Expand the
Virtual Memory" to optimize memory paging size.

Set Up the Gen5 Image Library

Gen5 provides two ways to define the file naming and location of generated files:

l Global setting: to apply the naming convention and file storage locations to all image files by default,
select System>Preferences>Image Save Options (under Initial Protocol Settings).

l Per Protocol setting (Protocol>Protocol Options>Image Save Options): to override the global
setting, apply distinct save options to image files, or to reconnect an experiment with its images.

More info: search for "Image Save Options" in Gen5's Help for additional information.

File Storage

Image file sizes are significantly larger than other data files.

198

9 - Saving Files



Widefield (standard field-of-view) image files
are at least 2 MB each.

A 4x4 montage per well of a 96-well plate will
require 3327 MB of storage space.

Confocal and Wide Field of View (WFOV) camera
imaging create files around 7.57 MB.

A 4x4 montage per well of a 96-well plate will
require 11.6 GB of storage space.

Using an external hard drive or another form of additional storage for images is strongly
recommended. However, storing images on a cloud drive is not recommended.

File Management System:

Gen5 stores the image files in a separate folder from the Experiment, Protocol, and Imager Manual Mode
(IMM) files. The image file location (Gen5 Image Library) is user defined. The setting is global and all
new experiments or manual mode captures will default to this system preference.

Apply global file naming and storage locations to all captured images.

Determine where Gen5 files will be stored: on a local computer or a secure network?

l Keep files local, if possible

l Except for Gen5 Secure for FDA's 21CFR Part 11 Compliance: use a network
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Because image files are very large compared to other Gen5 data
files, Gen5 handles them differently.

Except for image files, Gen5 experiment files can be stored
either in the Gen5 Database or in the Windows File System.

Image files are too big to store in the Gen5 Database. Image
files are stored in the Gen5 Image Library in a user-specified
location in the Windows File System or on an external hard disk
drive.

During the installation of the imager and Gen5 software, the save location for image files was defined
because this is required to run the imager. To change the location or determine where the image files are
saved, click System>Preferences>Image Save Options. This is a global setting for all image files
captured in Experiments and Image Manual Mode (IMM) files.

Image storage and file format options

l .IMM for imaging manual mode session files

l .XPT for Gen5 experiment files

l Image raw data (TIF file) for analysis

l Saving pictures for a presentation

l TIF, JPEG, PNG, GIF, BMP and EMF file formats

l Movie Maker (mp4, wmv)

l Review automated "Image File Naming Convention"

l Review Save Options: "File Naming Convention”

Gen5’s Zip File Feature: Exporting image files

Select "Create Zip file" from the File menu to neatly package your manual imaging session or experiment.
This will zip your images, protocol, and your analysis into one easily transferrable file.

Note: You must be in imager manual mode or have the experiment file open to use the Zip feature.
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Note: Experiment files and image files can be moved to other locations. But, never rename the
image file folder: renaming the image folder breaks the link to the experiment and Gen5 will not be
able to link to it. Image file folders should be a sub-folder under the experiment folder when moved
so that the experiment and image folders can automatically relink.

9.1.2 - Strategies for Data Management

Here are some suggestions to consider for most efficiently capturing the information you need, with the
aim of reducing file storage demands without compromising analysis capabilities. See also 9.1.3 -
Back End Data Management Tools on page 203.

1. Is stitching necessary?

a. Full well coverage and objects that spread greater than the field of view (e.g., neuronal
projections and large 3D biology) may require stitching montage tiles to a single image.
However, often this is not necessary and can double your data size. Typically, 2D cell
cultures at lower magnifications (4-20x) do not require a stitched image to analyze each
individual image separately.

b. Opening a montage (negative values) or the using ROI/Beacons sampling tools will enable
you to take patterns of images to sample across a well. This will automate the larger sample
size, give data on the well level, and not require the processing and storage of large-stitched
images.
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Open Montage with negative values (>=-50 µm):

2. Is Z-stacking necessary?

a. For spheroid work, when there is only one object per round bottom well, an autofocus step
can take you to the central focal plane where size can be measured. User-trained autofocus
may be the best option:

l Pros: much less data and faster.
l Cons: it is possible to lose fluorescent information for probes and
expressed fluorophores at different heights in the spheroid.

b. If not doing confocal work, do not decrease the recommended z-step size in Gen5 (minimum
number of z-slices necessary).
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9.1.3 - Back End Data Management Tools

Investing in hardware solutions for storing data will give you peace of mind that your data is protected.
It is best to set this up before running any analysis. Your organization’s IT team should play an integral
role in determining, installing and maintaining these systems.

1. Install a >= 10Tb hard disk drive (HDD) for any BioSpa or large ROI scanning system.

a. This is an easy solution. Agilent is happy to provide purchasing suggestions.

b. The size of the HDD is determined by use and desired time to run sweeps. With heavy usage
you are likely to acquire around 5Tb per week.

2. Large external RAID arraymay be the best option for single user or lab. The RAID can be
archived when full.

l For the more common “core type” usage or more secure storage at regulated
institutions you will need to sweep this internal storage onto user or
institutional networked storage.

3. Sweeping:

a. This can be done in the cloud (RAID automatically backed up) or to an external HDD.

b. Never perform a “Move” files, instead, always “Copy.” Then, review and check preferences
to be sure the files are exactly the same down to the last byte. This will give you confidence
that it is safe to delete the original data.

c. A more expensive option that significantly improves the speed of transferring files is a Solid
State Drive (SSD).

d. The ideal situation is every experiment and its images are saved on two hard
drives, (“simple” RAID):

i. USB external HDD #1 = Archive hard drive

Dedicate this HDD for archiving data. Either a zipped experiment with raw data only or
the images folder copied over before processing analysis steps. These files will be
smaller than analyzed files. When this HDD is combined with the one described below
you can feel confident that your data is safe.

ii. USB external HDD #2 = Working hard drive

Dedicate this HDD for your processed data and for working on analysis. More space
will be required to accommodate these bigger files. Assure you have enough space to
complete all imaging and data processing. Connect this HDD to your workstation, if
applicable, to run processing and analysis steps.
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10 - Plate Layouts and Reports/Exports

Customize Your Output

10.1 - Plate Layout 205
10.2 - Reporting and Exporting 207

Gen5 Layouts, Report/Export Builders

In an experiment, Gen5 lets you create a customized plate layout by
defining sample ID’s, dilutions, concentrations, standards, controls,
replicates and their placement/position on the plate.

Along with data acquired in the experiment, this information can be
exported to Excel or other formats and output in a Gen5’s default
report format.
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10.1 - Plate Layout

It's easy to define the plate layout with Gen5's tools for identifying samples, standards, controls and
blanks. Follow these steps:

1. Select Protocol>Plate Layout or
select it from the File tree.

2. In the Plate Layout Wizard that opens,
select the well types used in your assay
(check the boxes that apply).

3. Follow the wizard to define the
Concentrations or Dilutions, if
applicable, entering the values for each
type. Use the Next and Back buttons as
needed to add useful info for each type.
Upon Finish, Gen5 opens a grid or plate
map that represents your Plate Type.

4. Assign the well IDs to their corresponding
locations in the plate map by clicking in
the wells in the grid.
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l When you select a corresponding starting
number of Replicates in the Serial Assignment
box, the IDs change accordingly.

l Keep Next Dilution box checked and click to
assign replicates in either the row or column
orientations.

l You can also assign sample IDs using the Plate
icon in the File tree.

Set row or column orientation.
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10.2 - Reporting and Exporting

Gen5 Quick Export

Quick export to Excel is offered in several views. Just click the Quick Export image or data
buttons to instantly export to Excel. Only the currently displayed view will be exported.

Customize the Scale Bar

Gen5 v.3.12 and higher

Follow these steps to improve the appearance of the scale bar that Gen5 applies to image files.

In Manual mode or a well zoom, right-click for a context menu and select
Customize Image.

Or, in a well zoom, click Edit Image.

207

10 - Plate Layouts and Reports/Exports



Remember to customize the scale bar for the image set before adding it to a report or Power Export.

Gen5 Report and Export Builders

In experiment mode, you can customize the reports to include only the most useful information.

Explore the options available for including
or excluding data and formatting the
appearance of the report.
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To customize an export/report:

1. Click (or select the
builder from the File tree).

2. Respond the Gen5’s
prompts. In the builder
window, on the Properties
page, keep the default
“Automatic” selection
under Content, or select
Custom.

3. Then select Content in the
left pane to specify the
data to include in the
report and to customize
the layout.

4. After defining or customizing a report/export, click:

l

to export to Excel.

l

to preview or print the report.
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Increase Thumbnail Images in Power Exports

For imaging experiments, Gen5 gives you the ability to increase the size of thumbnail images in a matrix,
statistics or analysis results table. The best results begin by preparing the Excel worksheet to
accommodate the increased size of the images.

After defining the protocol, plate layout, and data reduction steps, define a Power Export:

Customize the Power Export template (change Properties to Custom as described earlier).

Then, select Edit Template to launch Excel to enlarge the height and width of cells.
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As usual, use the Add-ins toolbar to set up the report:
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Some trial and error may be necessary to properly size the images.

Note: this change does not apply to printed reports, QuickExport, nor CopyToClipboard.
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11 - Setup and Hardware

The Engineering Behind Your Imager

This section provides detailed explanations of the hardware for each of our imaging instruments.
Here you will find Laser Autofocus cube and LED/Filter cube installation and calibration information,
and internal schematics of the imagers. You will also find Labware adapters for different vessels and
their part numbers.

11.1 - Instruments and Accessories 215
11.2 - Objectives 221
11.3 - Imaging Cubes 223
11.4 - Labware 233
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11.1 - Instruments and Accessories

Instrument Components

Shown in this Cytation
cutaway illustration:

Multi-mode detection
system components, top

1. Quadruple
monochromator

2. Filter optical & Alpha
laser components

Not shown but available
in Cytation 5: Phase
Contrast (which would
replace the filter optical
and Alpha laser
components).

3. Imaging tube lens
and camera

4. LED and Filter cubes

5. Objective turret

Fully equipped Cytation 5 with filter-based optics
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This Cytation 7 cutaway
illustration shows some
of the same components
as above with the
addition of an upright
imager in the top:

1. Quadruple
monochromator

2. Upright imager

All models have an
upright imager with 4
fixed lenses and 2
brightfield light sources.

W-models also have an
inverted imager:

3. Imaging tube lens
and camera

4. LED and Filter cubes

5. Objective turret

Fully equipped Cytation 7 with upright & inverted imagers

Shown in this Lionheart
cutaway illustration:

Imaging system
components:

1. Phase Contrast
annuli,1 Brightfield
LED

2. Heaters in cover and
base (Lionheart FX
only)

3. Imaging tube lens
and camera

4. LED and Filter cubes

5. Objective turret

Lionheart FX
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Shown in this Cytation
C10 cutaway illustration:

Imaging system
components:

1. Phase Contrast,
Brightfield LED

2. Objective turret

3. Widefield LED and
Filter cubes

4. Confocal filter cubes
and disks

5. Imaging tube lens
and camera

6. Monochromator for
ABS, FL intensity,
LUM

Cytation C10
1 — Not available for Lionheart LX
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Agilent Imager Feature Comparison

Features Lionheart
FX

Lionheart
LX

Cytation 5 Cytation 1 Cytation 7 Cytation
C10

Alpha detection X*

Variable
bandwidth
monochromators
(FL)

X X X

Phase contrast
(4x-40x
objectives)

X X* X

Incubation up to
65°C1

X X X X X

Color Brightfield
(H&E stain)

X X X X X

Joystick positional
control (optional)

X X X X X

High capacity (6
objective) turret

X X X X X

Oil immersion
objectives

X X

Extended dynamic
range in FP, TRF,
FI

X X

1Temperature control varies: up to 40°C with Lionheart FX; 45°C with Cytation 1, Cytation 7, Cytation
C10; and 65°C with Cytation 5.
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Dual Reagent Injectors 

When applications require rapid inject-and-
read capability, or when it’s simply more
convenient to dispense one or two reagents
into a vessel inside the instrument, the
optional syringe-drive Dual Reagent Injector
Module is available. Installation is quick and
tool-free. Gen5 software allows intuitive
control over dispensing activities.

See 19 - Dual Reagent Injector

Not available for Lionheart LX

CO2 / O2 Gas Controller

Live cell assays require a controlled
environment, including regulation of CO2 and
O2 levels. The optional Gas Controller provides
precise monitoring and control of both CO2
(from 0 to 20%) and O2 (from 1 to 19%) levels
inside the instrument.

Lionheart FX offers an optional "Environmental
Chamber" stage insert that supports a Gas
Recharge feature to quickly restore gas levels
after the cover has been opened. Learn more
in the operator's manual.

See 20 - Gas Control

Not available for Lionheart LX
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Joystick

Some users may find the optional joy stick makes it easier to find
and focus on their samples, especially when using high-power
objectives. The joy stick offers more precise and varied navigation
than standard computer step controls. For example, the joystick
permits movement in both X and Y axes simultaneously.  Like
Gen5’s step controls, it offers precise focusing control. (PN
1320003)

After connecting the joystick, restart the instrument to
establish communication with it.

Note: Not available with Cytation 1 or 3.
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11.2 - Objectives

Up to six objectives are supported on most imagers. Confocal imaging requires a 20X, 40X, or 60X
objective.

Widefield Widefield & Confocal

Magnification 1.25x 2.5x 2.5x
4x /
4x
Phase

10x /
10x
Phase

20x /
20x
Phase

40x /
40x
Phase

60x

Numeric
Aperture

0.04 0.12 0.07 0.13 0.30 0.45 0.60 0.70

Resolution
(nm)*

5588 1863 3193 1719 745 497 373 319

Working
Distance (mm)

5 6.3 5.7 17 10 6.4-7.6 2.7-4.0 1.5-2.2

Depth of Field
(µm)

408 50.7 132.2 38.9 7.1 2.9 1.5 1.1

Field of View
(mm)

10.4 x
10.4

4.7 x
4.7

5.8 x
5.8

3.2 x 3.2 1.3 x 1.3 0.65 x
0.65

0.32 x
0.32

0.22 x
0.22

Manufacturer Olympus Zeiss Meiji
Techno

Olympus Olympus Olympus Olympus Olympus

Note: Confocal imagers do not support Zeiss 2.5X objectives.

See Install & Calibrate Objectives, LED-Filter Cubes, Confocal Cubes on page 225.

Important information about Objectives

Objectives need to be calibrated after installation and before first use (except oil objectives, which are
not calibrated). Calibration is performed via the Gen5 Imaging Configuration tab shown above. The goal
of calibration is to:

l Locate the center of the objective's optical axis relative the plate carrier in the X-Y plane
(horizontal),

l Find the focal point of each objective relative the plate carrier surface in the Z-axis (vertical),

l Reduce pixel shift for each of the filter cubes installed.

l

Important: All “W” model imagers and non-W models with high-power objectives (40X - 60X
air objectives) require an “objective setup plate” during Auto Calibration. Use the objective
setup plate provided with your instrument.
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l Cytation C10 and Lionheart “W” models require PN 1942519 objective setup plate.

l Cytation “W” models require PN 1852501 (which supports FL Illumination Correction).

l Other Cytation and Lionheart models use PN 1222531 to calibrate their high-power
objectives.

l Correction collar: 20X, 40X, and 60X air objectives have a correction collar. Start
with position .17 on the collar for cover slips and glass-bottom plates or .5 for
standard plastic microplates. Readjust collar as needed to support different plate
types, (as described on page 1).

Phase Contrast Objectives: At the factory, Agilent installs and calibrates the required phase contrast
components, a phase contrast objective and matching aperture. If adjustments are needed, contact
Agilent Technical Service.
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11.3 - Imaging Cubes

Widefield imaging uses LED cube-Filter cube assemblies. Confocal imaging uses confocal cubes, (as
described on page 230).

LED Cube and Filter Cube Assemblies

For fluorescence widefield imaging, the imager can contain up to four
LED cube and filter cube assemblies, one for each channel of image
acquisition color. The cubes are mounted on a mechanical slide, and
are easily removed and exchanged.  

Numerous wavelengths are available to support most known
applications of fluorescence microscopy.  The cubes are joined to work
together:

l bottom cube contains a high-powered LED and focusing lens,

l top cube contains the excitation filter, dichroic filter, and
emission filter.

The wavelength of the LED is matched to the color requirements of the
filters in the top cube.

l Gen5 helps ensure the LED cube is a proper match to the filter cube by
limiting your configuration options to matching components.

l LEDs are calibrated for light intensity every time the instrument is
powered up. LED calibration ensures a stable signal for the duration of
an experiment.

l Different LEDs have different maximum allowed current. So, it is
important to correctly identify the wavelength and position of the LED
cube in Gen5's Instrument Configuration prior to powering up the
instrument.

Easy access to slider for LED
and filter cube assemblies
(Cytation shown above)
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Typical LED Spectra

LED cube (bottom) and filter
cube(top)

Visit the Gen5 Document Library for comprehensive listings of LED and filter cubes,
and objectives.
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sample data

In Gen5, select System > Document Library for Imaging Objectives, LEDs and Filter Cubes or get
the latest information on Agilent's website: www.biotek.com.

Install & Calibrate Objectives, LED-Filter Cubes, Confocal Cubes

Important: To prevent damage to the LED cubes, follow the onscreen instructions for installing the
LED-Filter cubes. You must tell the imager which LED cubes are going to be installed in which location
before you install them and run Auto Calibration.
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Select System>Instrument Configuration. Double-click the imager item and click Setup.

Important: All “W” model imagers and non-W models with high-power objectives (40X - 60X air
objectives) require an “objective setup plate” during Auto Calibration. Use the objective setup plate
provided with your instrument.

l Cytation C10 and Lionheart “W” models require PN 1942519 objective setup plate.

l Cytation “W” models require PN 1852501 (which supports FL Illumination Correction).

l Other Cytation and Lionheart models use PN 1222531 to calibrate their high-power objectives.
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Make sure Gen5's 'Instrument Configuration' exactly matches the actual contents of
the LED and Filter Cubes and Objectives.

Select System>Optics Library>LED and Filter
Cubes.

If any components are missing from the list,
import them from Agilent's website:
www.biotek.com.

Swap the objectives and/or the imaging filter cubes when needed. To prevent over powering the LED
cubes, you must first tell the imager which LED cube configurations are going to be installed.

Important: Wear gloves when changing components to avoid contaminating them.

Step 1: Update Gen5 Settings
First, use Gen5 to update the imager’s onboard settings:

1. In Gen5, select Reader Setup.

2. On the Imaging Configuration tab, set the objective, LED cube and filter cube, and confocal cube
configurations for your components.

Recommendation: Generally it is best to install your lowest power objective, beginning
with 4X, in position #1, and higher power objectives in the subsequent positions. However,
it is best to install objectives with power lower than 4X in the last positions. Sample
sequence: 4X, 20X, 60X, 2.5X, 1.25X.
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3. In the Objective Configuration area, click the Access button to move the turret to that position.

4. When defined, click Send Values. (Keep this Gen5 window open until the rest of the procedure is
completed.)

Step 2: Physically install components
Open the access door.

LED-Filter Cubes:

Tools: 3/32 hex/Allen wrench

1. Reach in and pull out the filter slide.

2. Place the new LED cube in the defined position
(Position 1, 2, 3, or 4).

3. Use the hex wrench to screw the LED cube into
the filter slide.

4. Plug the LED's wire connector into the socket on
the circuit board.

5. Place the imaging filter cube on top of the
LED cube and screw it to the LED cube.

Objectives:

l Screw each objective into its defined position.

l Do NOT over tighten!

l Screw securely: Especially with high-power objectives, make sure the objective's adapter
threads properly into its place in the turret. Pay close attention when installing them. If you
feel a stop or misalignment, remove the objective and try again. Verify proper installation by
making sure there is no gap between the adapter and the turret.

Confocal cubes:

See Install the Confocal Imaging Filter Cubes on page 230.

Step 3. Run Auto Calibration
1. Turn on the imager. After a couple minutes, expect to hear a chirping sound indicating that

calibration is not completed. Press the plate carrier eject button to silence the alarm.

2. On Gen5's Imaging Configuration tab, click Auto Calibration.

This will take several minutes.
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Autocal Without Pausing lets you walk away from the imager during calibration,
(i.e., user interaction is not needed to complete the process). When not all components have been
changed, Quick Calibration saves time by only calibrating the new components.

Install the Laser Autofocus Cube

Laser Autofocus - Optional Accessory

Install the Laser Autofocus cube (PN 1225010) in Position 1 on
the slide (follow procedure for installing imaging LED and Filter
cubes).

Use the 3/32 Hex wrench to tighten the cube's captive screws.

Plug the cube's wire clip into the socket.

.
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Install the Confocal Imaging Filter Cubes

Confocal imaging models only

Tools: 3/32 Hex wrench

Important: Wear gloves when handling the confocal filter cubes. Be careful not to touch imaging
components.

Position 5 is reserved for the "Path Correction" confocal imaging cube. Be
sure to position the cube labeled “Path Correction” in Position 5 on the
confocal cube slider.

This cube does not need to be configured in Gen5.

1. Line up the confocal filter cubes (upside down) in the order defined in Gen5. Make sure the Path
Correction filter cube (shown above) is in Position 5.
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2. Put the confocal cube slider on top of the cubes in the correct orientation to position the cubes
correctly. (The thumb screw is at Position 1.) Use the hex wrench to tighten the captive screws
holding each cube.

3. Open the front access door. On the far left side, gently pull the confocal filter cube slider out.

4. Put the loaded confocal filter cube block on the slider, fitting the thumb screw on the bottom into the
slot on the slider. Tighten the thumb screw.
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Confocal Filter Cubes and LED Cubes-Filter Cubes Installed
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11.4 - Labware

Microplates and Other Sample Vessels

Imaging can be done in numerous sample vessel formats, including 6- to 384-well microplates,
microscope slides, various size Petri dishes and Corning® 25 cm2 rectangular, canted-neck cell culture
flasks. And, custom vessels that match the basic microplate geometry can be defined in Gen5 for use in
imaging.

Slide holder
PN 1220548

Petri dish holder
PN 1222240 38.7 mm
PN 1222246 35.5 mm

100 mm Petri dish holder
PN 1222242

60 mm Petri dish holder
PN 1222241

T25 Corning flask
PN 1222210 (Cytation)
PN 1452275 (Lionheart)

Cell counting chamber
PN 1322131 & 1320016

Multi-vessel adapter
PN 1450541

Nunc 4-well in adapter
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Lionheart Stage Inserts

Optional stage inserts may fill your assay requirements:

Environmental chamber for lidded plates
(For Lionheart FX only - LFX & LFXW)

T-75 square flask T-75 U-shaped flask

When changing stages, go to System>Instrument Configuration>Setup
and change the stage setting to tell the Lionheart which stage is installed.

Lionheart FX only: When using the T-75 flask stages, set “Dispense Tips” to
<none>, if they have been previously configured.
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Notices

Copyright

© Agilent Technologies, Inc. 2021, 2022. No part of this manual may be reproduced in any form or by any
means (including electronic storage and retrieval or translation into a foreign language) without prior
agreement and written consent from Agilent Technologies, Inc. as governed by United States and
international copyright laws.
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Contact Information

Agilent Technologies, Inc.

5301 Stevens Creek Blvd.

Santa Clara, CA  95051

Worldwide Sales and Support
www.agilent.com/en/contact-us/page

Technical Support and Service
Service Toll-Free US and Canada: (800) 227-9770

www.agilent.com/en/support

Email BioTek TAC: bio.tac@agilent.com

UK Responsible Person (UKRP)

Agilent LD UK Ltd

5500 Lakeside

Cheadle Royal Business Park

Cheadle, Cheshire SK8 3GR
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Symbols

CE Marking – Indicates compliance with the requirements of the Directive
2014/30/EU on Electromagnetic Compatibility and the Directive 2014/35/EU on Low
Voltage

CE-markering – Geeft aan dat wordt voldaan aan de vereisten van Richtlijn
2014/30/EU inzake elektromagnetische compatibiliteit en Richtlijn 2014/35/EU
inzake laagspanning Marquage

CE – Indique la conformité aux exigences de la directive 2014/30/UE sur la
compatibilité électromagnétique et de la directive 2014/35/UE sur la basse tension

CE-Kennzeichnung – Zeigt die Einhaltung der Anforderungen der Richtlinie
2014/30/EU über elektromagnetische Verträglichkeit und der Richtlinie 2014/35/EU
über Niederspannung Marcatura

CE – Indica la conformità ai requisiti della Direttiva 2014/30/UE sulla Compatibilità
Elettromagnetica e della Direttiva 2014/35/UE sulla Bassa Tensione Marcado

CE: indica el cumplimiento de los requisitos de la Directiva 2014/30 / UE sobre
compatibilidad electromagnética y la Directiva 2014/35 / UE sobre baja tension

UK Conformity Assessed marking is a certification mark that indicates conformity with
the applicable requirements for products sold within Great Britain.
De 'UK Conformity Assessed'-markering is een certificeringsmerk dat aangeeft dat
producten die in Groot-Brittannië worden verkocht, voldoen aan de toepasselijke
eisen.
Le marquage UK Conformity Assessed est une marque de certification qui indique la
conformité aux exigences applicables aux produits vendus en Grande-Bretagne.
Die Kennzeichnung „UK Conformity Assessed“ ist ein Zertifizierungszeichen, das die
Konformität mit den geltenden Anforderungen für in Großbritannien verkaufte
Produkte anzeigt.
Il marchio UKCA (conformità valutata del Regno Unito) è un marchio di certificazione
che indica la conformità ai requisiti applicabili per i prodotti venduti in Gran Bretagna.
El marcado UKCA (UK Conformity Assessed) es una marca de certificación que indica la
conformidad con los requisitos aplicables para los productos vendidos en Gran
Bretaña.
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